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Welcome

        Welcome to RoofCalcWriter Help

  Simply enter the numbers from your estimate sheet, containing measurements of field, top ridge, hips, valleys, rakes

and eaves. As you enter 

numbers your Job Cost Grid is instantly updated. You can change any of the wording including numbers in the Divisor

column. Click a button

and send your estimate by email. email. email. email. Don't want to  enter roof measurments use our new Quick  BidQuick  B idQuick  B idQuick  B id  form. Every detail

of your bid is saved and

can recalled in seconds. Send an email with your price(s) with a couple clicks. Don't want to bid by the square and

want to enter prices in

detail read this.this.this.this.

Click a button and print pr int pr int pr int every detail. 

View your pitch and waste de tailswaste de tailswaste de tailswaste de tails  with just a click. View your actual b id numbersactual b id numbersactual b id numbersactual b id numbers  exactly as they were entered.

3/8/2010 Document.html

C:/Program Files/…/Document.html 2/147



  

Note: Your Total Squares are program determined by adding Roofing Squares + Starter squares + Ridge squares

   A bid price is determined by your total squares times your price per square.

 Felt, Valley Metal, Nosing and OSB-plywood are for your information and have nothing to do with your total price.
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Whats New in RoofCalcWriter

    We have added many new features to the RoofCalWriter program. We view the RoofCalcWriter

   as never being finished. 

 The features listed here are the main new features.

Added 03-18-09 to RoofCalcWriter program

Roofcalcwriter vista complient.

New email program that sends html emails with color, font and embedded images.

Minor bugs fixed.

Added 11-19-08 to RoofCalcWriter program

New email program that is very easy to use. (Just enter the email address and send)

Emailed Documents to include customers address in file name.

Added double-click to erase row contents in material list (Detail Pricing).

Source code optimized to work faster.

Added 11-04-08 to RoofCalcWriter program

New File  backupFile  backupFile  backupFile  backup and restore progarm to Usb Flash drive. 

New Auto backup utility that backups files as they are changed or created. 

New form to report suggestions, ideassuggestions, ideassuggestions, ideassuggestions, ideas  or whatever. 

Small improvements thruought the program.

 Added 07-04-08 to Detail Pricing

Ability to save items in Labor and Misc/Other gr idMisc/Other gr idMisc/Other gr idMisc/Other gr id for future use. 

New columns added to Misc/Other and Labor gr idsLabor gr idsLabor gr idsLabor gr ids  that calculates and totals numbers entered. 

Ability to open your saved roo f remova l pr icesroof remova l pr icesroof remova l pr icesroof remova l pr ices from Misc/Other grid in Detail Pricing 

Ability to add Squares, Hips, Top Ridges, Rakes, Eaves and Valleys  calculations from Misc/Other 

    and Labor grids in Detail Pricing by right-clicking. 

Ability to open your saved labor prices and enter them by clicking the numbers. 

Ability to add squares in Labor and Misc/Other Grids by double-clicking the Units column.

Added 07-04-08 to RoofCalcWriter program

Option to check for program updatesprogram updatesprogram updatesprogram updates  on program opening.

Option to view and select the fixed width fonts on your system for underline typingunderline typingunderline typingunderline typing .

   Added 06-07-08

Added 5 new fields to document markersdocument markersdocument markersdocument markers     

New helper window for entering document markers.

(Changed) If information for document marker is not supplied, marker is erased. (Marker will not show on

printed documents) 
Ability to add or type into underlined f ie ldsunderlined f ie ldsunderlined f ie ldsunderlined f ie lds . 
Right-click anywhere in paragraph and Sentence manager to enter todays date.

Ability to add sentences to any location.  

Ability to add saved sentences to all documents (Not just proposals)

New popup ca lendarca lendarca lendarca lendar  for entering future or past dates anywhere in your document.

Added 05-22-08

New detail pr ic ingde tail pr ic ingde tail pr ic ingde tail pr ic ing mode for users who want to produce bids by entering individual items  for materials,

    labor and subcontract 

Ability to get an online maponline maponline maponline map  to the address listed in your bid. (Choose from 3 map Providers)

Ability to get an online weather reportonline weather reportonline weather reportonline weather report (Choose from 3 weather providers)

Ability to get program updatesprogram updatesprogram updatesprogram updates  to always have the latest software features with just a button click.

Ability to add waste waste waste waste to your squares for valleys, hips and rakes.

Ability to roundroundroundround your material units up to the next full unit.

Ability to round your total squares up to the next full square.

Ability your bid prices up to the next full dollar.

Ability to create and print a  detail workprint a  detail workprint a  detail workprint a  detail work  order in price per square or detail pricing mode.

Ability to print your deta il pr ice listde ta il pr ice listde ta il pr ice listde ta il pr ice list.

Two new fields  have been added to the address bookaddress bookaddress bookaddress book  and the ability to get an online map to the address

selected.

Bonus Personal Bonus floating C ameraC ameraC ameraC amera    Get pictures or parts of pictures anywhere on your screen.

New keyboard shor tcutskeyboard shor tcutskeyboard shor tcutskeyboard shor tcuts  for every task.
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Ability to Email documentsEmail documentsEmail documentsEmail documents  created with just a couple clicks.  

Quick BidQuick B idQuick B idQuick B id, In this release we made improvements to allow adding and saving items to be used over and
over.

 Use it when entering roof measurments is un-needed (Dry-rott, etc) or for storing extras.      

 Improved pr inting pr inting pr inting pr inting layouts 
     Prints all your grids including individual numbers

Send an email containing a copy of your bid prices in the email message with Just

    a button click            

C ontext sensitive  helpC ontext sensitive  helpC ontext sensitive  helpC ontext sensitive  help.
      Pressing F1  Opens help to the topic information linked to the control that you have selected.

Recent f i le  l is t.Recent f i le  l is t.Recent f i le  l is t.Recent f i le  l is t.

    To conviently open the last files you have worked on.

C hoose  your pr inte rC hoose  your pr inte rC hoose  your pr inte rC hoose  your pr inte r  from a list printers installed on your system.

New menusNew menusNew menusNew menus

New Document creation features
Capture pictures  

   Put a rectangular portion of any part of your screen into your documents by selecting it with your mouse.
 SuperScript/SubScript   Give text a different look.

 
Format Painter        

   To conviently copy formating of text.
Insert symbols  

Date and or time    Select from 14 different Date/Time formats.

Insert Tables   Easily insert tables into your documents.

Quick Squares  Calculator   When you want different squares.  

Document rulers  
    Two rulers, a side ruler and a top ruler. Both rulers display measurements in inches (default) or centimeters.
   The top ruler calculates the page size depending on the paper type (letter, A4, etc.) and margins you've
chosen in the Page Setup
   dialog available from the file  menu. The page orientation, portrait or landscape, will also affect the width of
the page and therefore the ruler. 
Indent Margins

     You can change the paragraph left and right indent margins by sliding the margin indicators located on the
ruler tool bar or set
    them from the paragraph dialog  window available in the Format menu. 
Word Wrap

     There are three choices of Word Wrap.
    1. Wrap to Ruler:  This usually is the best choice since the result is basically a WYSIWYG (what you see
is what you get) 
       screen display. This means that the screen display is basically the same as how the document will be
printed.
    2. Wrap to Window:  Does what it says.  Text paragraphs that do not have a hard carriage return/line feed
will expand and contract 
        based on the size of the Classy Writer window.
    3. No Wrap: (Probably not very usefull) Not sure why anyone would choose this option.  Basically it means
a paragraph is 
        displayed in one, long, line. The width could be as long as 140 inches.
     Note:  Word wrap is only for screen display and does not affect the printed document.  When printing,
Classy Writer
       uses the Page Setup measurements to structure the layout. 
Print Preview

    See how your documents will look before printing. 
Print Layout support

      Header, footer support along with paper size, margins, etc.  You may also change the default printer and
print directly from
    the setup dialog.  Changing the printer from the Page Setup dialog does not change your windows default
printer. 
    It only changes where the current document will be printed.  

C ell background shadingC ell background shadingC ell background shadingC ell background shading .
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Main Window

 The Main Window

This is always your starting point and here you do most of your work. All other windows are opened from here.
You do not have to open any other windows to produce an estimate.

Windows opened from here are 2 different types.
One type opens as a separate form. 
The other type opens a window that floats above the form below.

All your bid information, for an estimate is entered here eg; Contact information, bid calculations and job specific
details.
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Calc Details Window

  Click this toolbar button to open your pitch and waste reporting window  

The Calc Details window shows details of the totals of roof measurements you have entered.

You can drag this window to any position and it will be remembered.

    

The amount column are totals of numbers you have entered.

The pitch amount column shows the decimal amount added for the roof pitch selected.

The  Ft added column shows how many feet are added for pitch.

The sub-Total column shows the new total with pitch added.

The Valley waste shows the amount added for valley waste.

The Hip waste shows the amount added for Hip waste.

The Rake waste shows the amount added for Rake waste

The Valley, Hip and Rakes waste is set by you in options.options.options.options.

The waste column applies to Roof Area Square Feet you have entered in job cost d iv isor columncost d iv isor columncost d iv isor columncost d iv isor column.

Enter any number less than 100 to account for waste. Here we have entered 95 amounting to 5% waste.      
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Number Detail Window

    Compare  this report to your written numbers

To open the number details window click this tool bar button      

The Number Details window holds all of the individual numbers you have entered.

These numbers are exact duplicates of the numbers you have entered from your written numbers.

Use this as a check list and compare these numbers to your written numbers

You can drag this window to any position and it will be remembered.

   

Tip:

     Ever come up a couple square short on a job? To find out why, the easiest place to start is to

compare this report to your written numbers.
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Quick Bid Window

The copy to extras button is only for use when in Per Square Pricing Mode.

Click this button to open Quick Bid    Or open it from the View menu. Ctrl+Q

 Use this quick bid when entering roof measurements is un-wanted.
  or
 Enter extras or options to include with your bid.

You can add and save items you use often, just click the save button.

 You can drag this window to any position and it will be remembered.

       

 To use for your extras in your Job Cost grid click the copy to extras button.

   You may not want to add roof measurements for:

Leak repairs

Dry-rot repairs

Skylights

Any roof repairs

Inspections

Certifactions

 Use it for anything you want to have saved record of, that can be recalled with just a couple clicks.

 

Warning:
 Be aware that using quick bid and entering roof calculations you could end up with more than 1 price !

 You can use this for any job specific details.
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Price Per Sq Window

The price per square numbers are for example only. You must enter your prices.

The price per square floating window is opened from the Job Cost grid  

 This window floats within and above the main form. This form aids in entering your pre-determined numbers for

Price Per Square. This form is a copy of your price per square main form. You can select any of the options to update

these prices, eg: Roof Pitch, Tear-off, etc. You can not edit these numbers from here.

Click any of the blue triangle buttons to copy the prices per square to job cost.

To enter or edit your price per square prices click   icon on the tool bar.
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Templates Overview

 We have provided a few templates for example. You can rename, edit or delete these templates.

Using templates allows you to make pre-determined roofing types with different material quantity needs.
Each template controls the first 8 rows in the Job Cost grid.
Each time you make a new template the first 8 rows are added to the new template.

      

 All of the data within the red outline will be saved with your template. The green outlined cells are system
maintained.

        

  Managing your templates  

   

 New template:

Type a descriptive name in the templates box and click the save icon.

 Delete a template:
Erase the name in the template box and click the save icon.

Rename a template:

Type over a name in the template box and click the save icon.

When saving your templates your bid informationbid informationbid informationbid information is also saved along with your template.

.
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Quick Start

To get started quickly with choosing very few options do this:

   

3/8/2010 Document.html

C:/Program Files/…/Document.html 13/147



Template Details

For information to rename, delete or add a new template click here.here.here.here.  

Note: You can change data in the Job Cost grid and not save it to a template for any estimate.
Be aware that saving an estimate based on a template and the estimate is later opened it will not match the
currently selected template. All the data in Job Cost is replaced by your saved estimate data.

   

      

Templates control the first 8 rows in the Job Cost Grid, down to "Total Squares" (Shaded light yellow)
Each row totals a specific roof calculation. The Divisor numbers you enter calculates and produces your units.
You can leave any Divisor row blank and it will not be included in calculations. 

Clicking the viewer icon   opens the floating cell information below. This viewer gives information on the cell 

that has been clicked. Here we have clicked the row that totals eaves. All the eave lines are red. The ridge on rakes 
has been checked, so that part of the roof plan is also red. The red text changes with instructions for each cell
clicked.
Lines on the roof plan also turn red to visibly see which cell gets totaled.

 

  Move your mouse slowly over the Job Cost grid to get information about each cell. 
  

 You can also double-click any of the yellow shaded cells for cell information.
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Editing the Job Cost Grid

The Job Cost Grid displays and calculates your bid numbers.

Shown here is the way the grid looks in Per Square Pricing Mode.

The divisor column divides all your totals, what you enter in this column is very important !

  The Job cost Grid is the main focal point of the RoofCalcWriter program. It collects all the numbers you
have entered and divides them into the usable units you have specified. It totals your squares and
calculates your total price based on the price per square you enter. 

The yellow shaded cells in the units column is where you will always enter your price per square.

The top row is a total of your roof area measurements with pitch added + 5% for waste. 
The 3977.70 is the total of your actual roof measurements.
The Sub-Total is 3977.70 x 1.08 = 4295.92, = pitch has been added.
The waste is 4295.92 / .95 (Divisor) = 4522.02. If you do not want to add for waste then enter 100 as the divisor.
No waste has been added for valleys, hips or rakes. See optionsoptionsoptionsoptions .

You can see the details of all your calculations by looking at your  formformformform or your  form.form.form.form.

See: Price Per Sq VS Detail PricingPrice Per Sq VS Detail PricingPrice Per Sq VS Detail PricingPrice Per Sq VS Detail Pricing

           

You can type into any of the light yellow shaded cells  
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The second row is a total of your Hip feet + Ridge Feet and optionally your Rake ft if this is checked  

The third row is a total of your eave mesurements and optionally your Rake ft if this checked    

The fourth row is a total of your roof area measurements with pitch added (If needed)
The fifth row is a total ft.of your valleys with pitch added (If needed)
The sixth row is a total of your roof area measurements with pitch added (If needed) (usefull for OSB or ?)
The seventh row is a total ft. of your eaves.
The eighth row is a total ft. of your rakes with pitch added (If needed)
All the numbers in the unit column are calculated by total ft. / the Divisor you enter.
To not use any of these rows leave the Divisor blank.
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How Total Squares are calculated

A square is always 100 square feet.

Total squares are calculated like this:
Roof Area squares + Ridge squares + Starter squares = Total Squares

Ridge squares are calculated like this:
Each bundle of ridge is .33.33 square feet or 1/3 of a square.(The 3 you entered above)

Starter squares use the same calculation.(The 3 you entered above)

Example:

Using the above Bid Information
Ridge covers 32-ft per bundle and we have 32-ft ridge = 1-bundle or 1/3 square.
Starter covers 36-ft per roll and we have 36-ft = 1 bundle or 1/3 square.

If we have 25 squares of shingles are total would be:
25 + .33 +.33 = 25.66 squares

Note:

To not have starter and or ridge added to your total squares leave the bid information field(s) blank.
We realize that many bundles or boxes of ridge or starter cover  different amounts. Enter the number 
and description of what you use in the Job C ost Grid.Job C ost Grid.Job C ost Grid.Job C ost Grid.
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Ridge and Starter On Rakes

  Ridge on Rakes

The ridge on rakes has become very popular and is specific to composition shingles.

The benefits:
  Looks.
  Felt is folded over the barge rafter and tends to be more watertight.
  Rake metal is un-needed.

The drawbacks:
  Cost of additional ridge.
  Cost of additional labor.

If the Ridge on Rakes checkbox is checked your rake feet will be added to your ridge feet.

Roll starter on rakes

If the Roll Starter on Rakes is checked your rake feet will be added to your eave feet.

Example Ridge on Rake:

You have 32ft of ridge and 32ft of Rake and have 32 entered as your divisor. This would produce
2 bundles of ridge, 1 for ridge and 1 for rake
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Save By ?

 The RoofCalculator program automatically saves your bids by the option you choose.
 

Save by Last Name Address

   Use this option for one time customers.Your saved bid will look like this: 
  

Save By Company Name-Job Address

  Use this option for ongoing customers (Contractors etc.) Your saved bid will include:

  Company name, Lot number,  Plan # and job address. Your saved bid will look like this:      
  

Lot numbers and plan numbers are not required. Company name and Job address are required.

When saving your job by Last name address, if Last Name or address is missing you will be prompted to supply
them.

When saving by Company Name, if Company Name or Job Address are missing you will be prompted to supply
them.

Note:

Either way you save your bids the names and contact information will be added to your address bookaddress bookaddress bookaddress book .
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Entering Bid Numbers

This you will do with almost every estimate. (Except when using Quick Bid)

When entering your Roof Area measurments you will doing mulitiplication and there will be 2 boxes

to enter numbers into.

  Enter your number into the first box and click the Calc button or press enter. Your cursor will go to the

second box, enter your next number and click the Calc Button or press enter. Your cursor will go back to the

first box. At this point both boxes will be empty. The text in Roof Area will turn red to indicate it holds a value.

At this point the total of multiplying the 2 numbers has been added to:

The roof area option

The calculation detail window

The Job Cost grid

The Numbers Detail Grid

The Pitch and Waste Grid

Pitch has been added if needed.

Repeat this process until all your roof area measurments.

Click the Next option button or select any other options and the 2 boxes will disappear and only 1 box will

be visible. Enter a number into the box and click the Calc Button or press enter. Continue this process

for all the options you will need.

  If you make a mistake and want to remove a number, select the number

from Calculation Details and click the remove item button. The Clear All button clears everything on the

current bid.

         2 Boxes for mulitiplication        1 box for addition

          

  Tips:

  It is usually easier to press the enter key after you enter each number.

  Sometimes it is desirable to subtract from your totals 

  For addition just put a minus sign in from of the number -33 and press enter

  For mulitiplication put a minus sign in front of only 1 number, like this 55 x -23.
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Adding Roof Pitch

   If you are climbing on roofs and measuring the actual roof you will not need to add for pitch.

 If you are measuring from the ground or measuring roof plans you will need to add for pitch.

 When measuring roof plans the pitch will be noted on the plans. When measuring from the ground

 you will need to know how to dete rmine  your roo f p itchde te rmine  your roo f p itchde te rmine  your roo f p itchde te rmine  your roo f p itch to add the correct amount.

 The RoofCalcWriter program will add the correct amount for pitch by clicking the    check box. 

 Then select the proper pitch from the drop down list. The pitch table below lists how much is added for each pitch.

Example:

 Roof is 6/12 pitch and measures at 2,400 square feet 2400 x 1.118 = 2,683 or 26.83 squares 

                              

Note:

   When opening the RoofCalculator program the last pitch used will be selected and the last state of the

  add Pitch checkbox.

Related Topics:

How to measure a roofHow to measure a roofHow to measure a roofHow to measure a roof
How to measure from the  groundHow to measure from the  groundHow to measure from the  groundHow to measure from the  ground
How to measure roof plansHow to measure roof plansHow to measure roof plansHow to measure roof plans
How to de te rmine  pitchHow to de te rmine  pitchHow to de te rmine  pitchHow to de te rmine  pitch
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Entering Contact Information

For first time customers enter your contact information for a estimate here or your address bookaddress bookaddress bookaddress book .

If you have selected save-bysave-bysave-bysave-by:

Last Name-Address, the First Name, Last Name and Address fields will be a light yellow and are required.

If you have selected save-bysave-bysave-bysave-by:

 Company Name-Job Address, Company Name, Company Address and Job Address fields will be a light

 yellow and are required.

When saving your estimate all the information entered here will be copied to your address book .address book .address book .address book .

 

If you enter contact information here for a new customer, it will only be added to your address book when you 

save your estimate.

You can also send an email from here by entering a email address and clicking the email button 

 

3/8/2010 Document.html

C:/Program Files/…/Document.html 22/147



Address Book Overview

 The main purpose of the address book is to eliminate the need to enter contact information

for customers you have done work for previously. When you save your estimates for a new 

customer the  contact information is added to your address book.

 You can enter new contacts, edit contact information, send an emailsend an emailsend an emailsend an email or enter contact information

into your estimate. Click the map button an get an online maponline maponline maponline map to the address in the text boxes.

  

Related
 Address Book more  detailAddress Book more  detailAddress Book more  detailAddress Book more  detail

 Send by EmailSend by EmailSend by EmailSend by Email

 Get an online mapGet an online mapGet an online mapGet an online map
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Save As Tool Bar Icon

      Using File SaveAs    

Open File save as from the toolbar button or from the File menu Ctrl+A

As you accumulate a lot of roofing bids with file saveas you can organize your files into folders.

          Examples:

 A track of homes.         .

 A customer you do a lot of work for.

 Jobs in progress.

 Finished Jobs.

 Coming up.

 Unpaid jobs, paid Jobs.

 Bids are saved by Last-Name-address or Company-Name-Job-Address.

 The bid below is being saved by Last-Name-address.

Our software supplies the file name and is filled in automatically. We recommend this not

be changed. 

To create a new folder click the folder icon 

  Below we are showing some examples:

  

Highlight any file and press your keyboard Delete key to delete a file.
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File Save

   File Save

 To save your estimate click the Save icon   Or  press Ctrl+S on your keyboard or from the File menu.

  As you build up a quantity of roofing estimates they can get unmanageable. Old roof bids can get difficult to
find, if not properly organized.

  When starting your estimate, enter your customer last name and address. When saving your estimate the file
name box is automatically updated with this information. We suggest you not change this. With this method 
estimates are easy to find and recall. If you have more than one bid with same last name, the address will always
be different .

After you have entered your bid information, click the save button on the tool bar and your bid is saved.
You will the recieve a confirmation message box.

          

To save your bid to a different folder click the Save-asSave-asSave-asSave-as  button on the toolbar.   Or  press Ctrl+A

  on your keyboard or from the File menu.
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Printing RoofCalcWriter

To print your estimate click the print icon on the toolbar   Or press Ctrl+P on your keyboard

Your printed estimate will look similar to this:

 Compare the number details grid to your written estimate as a safety check.
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RoofPlan

The roof plan serves no meaningfull purpose other than to display to the currently select option.

 When you click an option button the lines on the roof plan turn red to indicate the currently selected

option.

In the roof plan below the   Top Ridge option is selected.
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Using the Address Book

  To search for a name start typing into the box provided and the first occurrence of the letter you typed

will be highlighted. As you type each letter will added to your search and each word matching will be highlighted.

  Or you can scroll the scrollbar until you find the name you are looking for. Once you have selected the name

you are looking for click it and it will be highlighted. To edit your selection click the edit button.  To copy the

selection to your estimate double-click it or click the insert into estimate button.

 You cannot send an email from here without entering a va lid ema il address va lid ema il address va lid ema il address va lid ema il address.  
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Email Overview

  For the increasing spam, more and more SMTP servers installed content filters which stopped spam efficiently but

also killed many valid emails. To deliver the email to the user correctly, you have to avoid the email deleted by the

content filter as a spam.

The following  lists some points to avoid anti-spam. 

  To send email  we have to send the emails one by one

  to multiple recipients. That is because every recipient has different smtp server.

 The email program provides an excellent way to send a quick email with little effort. 

   You can open the email program from your address book or from the RoofCalculator main screen.

  Or from Paragraph and Sentences manager screen from the tool bar button to send the current document by email. 

You can find and add a attachment by clicking the  Browse button  

 By clicking the add prices button the prices of your estimate are added.  

   You must be connected to the internet to send an email.  

     

      

Notes:

The from email must be filled in.
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All email may be classified as spam and placed in a spam box. You may want to follow up on important documents.

Be sure your email is entered correctly to get a reply and a copy sent to you. (If Cc to sender is checked)

You may think that you can email without the recipient knowing who it is from, but in fact a person that can read 

email headers can tell.

See also Email Se tupEmail Se tupEmail Se tupEmail Se tup

See also: SMTP ServersSMTP ServersSMTP ServersSMTP Servers
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Email Address Validation

 There are many rules concerning email addresses, we will cover a few here.

 

 The RoofCalculator program does not know if an email address actually exists. We 

check for validation only to determine if your email can be delivered.

  An email address must contain the following:

At least 6 characters in length. 

An ("@") sign

At least 1 (".")

  An email address cannot contain the following:

Spaces

Start with a period

Start with ("@") sign

Have more than 1 ("@") sign

An email address can contain more than 1 period (".") 

Note:

Some some isp's may require validation that is not covered here.

To read more on the internet:
http://en.wikipedia .org/wik i/E-ma il_addresshttp://en.wikipedia .org/wik i/E-ma il_addresshttp://en.wikipedia .org/wik i/E-ma il_addresshttp://en.wikipedia .org/wik i/E-ma il_address
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Job Cost Pop Up Calculator

Only available when using Per Square Pricing Mode

The addition pop-up addition calculator allows you to easily calculate extras, when you have many

extras to calculate. Click the transfer button and your extra price will be copied to extras in Job

Cost and calculated. Open by clicking the    icon on the job cost gr idjob cost gr idjob cost gr idjob cost gr id.

     

You can also type in your extra price directly and it will be calculated.

You can also use this calculator for anything you want, just do not click the transfer button.
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View All Grids

See floating price Per Square grid belowbelowbelowbelow

 You can move these floating grids to any position or click the  to hide them. Clicking the red X does not loose their

data.
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Other Settings

Persistant settings are settings that will be remembered each time you open RoofCalcWriter.

 RoofCalcWriter persists these settings:

The last roof pitchroof pitchroof pitchroof pitch you have selected. 

If you added pitchadded pitchadded pitchadded pitch:   

Your last templa tetempla tetempla tetempla te  used: 

Your last save-bysave-bysave-bysave-by: 

You last used pricing method (Detail or Per Square Pricing)

Your last used floating window placements for:

Quick  B idQuick  B idQuick  B idQuick  B id
Ca lc DetailsC a lc DetailsC a lc DetailsC a lc Details
Number  DetailsNumber  DetailsNumber  DetailsNumber  Details
Pr ice Pe r Square  floating windowPrice Pe r Square  floating windowPrice Pe r Square  floating windowPrice Pe r Square  floating window
Ce ll Information V iewerCe ll Information V iewerCe ll Information V iewerCe ll Information V iewer

You can drag these windows to a convient location and it will be remembered.

Your Document Designer and Sentence and Paragraph  Persistant Settings

The last highlight color used.
Your forms height, width and position on the screen.
The last Date format used.
The last font name, size and if bold.
The side ruler inches or centimeters setting and visible state.
The top ruler inches or centimeters  and visible state.
The last word wrap setting.
All the toolbars visible state.
Print margins, orientation, paper size, header and footer settings.

Your Email Persistant Settings

 All of the below will also be persisted.

Sending an emailSending an emailSending an emailSending an email

      

     Sender Name

      Sender Email       

  Your Options Persistant Settings

Sales tax 
Overhead

Profit

Payroll Tax

Rounding bid prices

Rounding material units

Rounding full squares

Waste for valleys

Waste for hips

Waste for rakes

Weather and map provider

Your State and City

Fixed Widt font settings

Auto program updates setting

File backup and restore automatic settings.
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Ridge and Starter Per Sq

The purpose of this option is to allow you to add ridge and starter to your total squares.

The numbers you enter here will determine how much is added.

The numbers below indicate we want 2 bundles of ridge to a square and 3 bundles of starter per square.

   

 A simple example:

   From your estimate sheet you have entered the following:

Roof area 10x10 = 100 sq feet or 1 square

Ridge 33 feet = 33/2  = 1/2 of a square or .5 squares

Starter 36 feet =  36/3  = 1/3 of a square or .33 so your total square would be:

Roof area           1.00 sqs

Ridge                   .50 sqs  

starter                  .33 squares   

Total                   1.83 squares

Notes:

   If you do not want to add ridge and or starter to your total squares leave the Bu Ridge Per Sq

 and or the Bu Starter Per Square blank.

 Be aware that not including starter and ridge on a roof could amount to a lot of money.

When you save your Templates all the Bid Information is saved with your Templa te .Templa te .Templa te .Templa te .
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File Open

 You can open this dialog from the main toolbar by clicking   or from the File drop down menu.

  Select any file and click the open button or double-click a file and it will be opened.

You can also delete files by selecting them and pressing delete on your keyboard.

You can also create new folders by clicking the folder icon:  

All the RoofCalcWriter bids are saved with a .bid file name extension. You cannot open any other file types.
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Using this help File

Opening Help

Pressing F1 on your keyboard will always open help. If no control has focus the Welcome Page will will open.

You can also open help by clicking the tool bar icon   or Pressing F1 on your keyboard.

You can also get help by the clicking Help   on the form top menu.

Context-sensitive help is a kind of help that is obtained from a specific point in the state of the software, 

providing help for the situation that is associated with that state.

  Example:

   If you click on the job cost grid and press F1 a topic specific to the job cost grid will open.

  Example 2:

   You click on any textbox and press F1 a topic specific to the textbox you have clicked will open.

You can print any topic by clicking the  icon on the help toolbar.

Clicking blue text that looks like this will open a similar topic, or more help with that topic.

You can search for a help topic by clicking search   a dialog box will open

 for you to type in your search term.
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Buy RoofCalcWriter

 To buy RoofCalcWriter online click here.here.here.here. (You must be connected to the internet)

Enter ing your unlocking codeEnter ing your unlocking codeEnter ing your unlocking codeEnter ing your unlocking code

The order process

  RoofGenius collects no credit card information.

 FastSpring.com is the authorized payment processor for RoofGenius. FastSpring.com is a service for vendors of

electronic media to distribute and market their products to the world. FastSpring.com allows products to be securely

registered or purchased with a credit card over the Internet. All FastSpring..com transactions are protected by an

extremely high level of encryption (highest allowed by U.S. law).  FastSpring. accepts the following payment options;

Visa

MasterCard

American Express

Discover

PayPal

Mail Check or Money Order

Once your payment is authorized here is what happens;

If you have not already done so, download the software.

FastSpring.com instantly sends you an email containing the transaction number and your software unlocking code. Go

to your email and get your unlocking code. Enter the unlocking code into the software when prompted. Write your

unlocking number down and keep it in a safe place.

FastSpring.com also sends us the following information;

Your name, address, phone number, payment amount, order ID and tracking ID. We do not receive any credit card

information.

3/8/2010 Document.html

C:/Program Files/…/Document.html 38/147



Entering Your Unlocking Code

After you have purchased our software, follow these steps to register the RoofCalWriter program.

   From the main screen on the top tool bar click Tools     

   Click Register  from the tools menu.

   A dialog opens: Notice the version number.

           

        

   Enter you name or company name into the Register to: field

   Enter the regristration number you recieved by Email from Regsoft.com

   Click the submit button. 

   If you enter a valid number a Thank You message will be displayed.
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Price Per Square Overview

 Important ! 

 All the prices we have provided are for example only. You must enter your prices.

 Price Per Square eliminates the job by job tedious task of costing out job cost details to determine how 

much to charge per square. Change just 1 number or click 1 Option Button and all the prices per square are 

instantly updated. Once your prices are entered and saved  all that is needed  is to click on a few selections 

and your  price per square is calculated. Add your number of squares and a total price is produced.

Every price per square can be broken down as follows:

Labor per square + Material per square + Overhead per square + Profit per square = Total Price Per Square

After you have entered your prices the the following items are program calculated:

 Materials

   different  types of roof coverings

   8 different felts

   Plywood-OSB

   Sales Tax

 

 Labor

  Lay roofing on 6 different pitches  from Flat to over 8/12

  Lay plywood-OSB on 6 different pitches from Flat to over 8/12

 Roof Removal

  Remove 1 layer on 6 different pitches from Flat to 4/12 to over 8/12  

  Remove 2 layers on 5 different pitches from Flat to 4/12 to over 8/12  

  Remove 3 layers on 5 different pitches from Flat to 4/12 to over 8/12 

  Remove Over 3 layers on 5 different pitches from Flat to 4/12 to over 8/12  

 Other 

  3 different levels of profit

  Sales tax (If applicatible)

  Overhead

  Cleanup

  Profit
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What's New In Price Per Square

We have added many new features to make Price Per Square more flexible and easy to use.

     Keypoints:

 Price Per Square calculates a roofing price for 9 different roof types

 All 9 roofing types are user defined.

 New felt grid for 8 different felt types.

 Each roofing type can have it's own felt type.

 Popup Calculator added to aid in calculations.

 New faster loading grids.

 Ability to copy price per square prices to Job Cost by clicking.

 New menus

 New keyboard shortcuts for keyboard users.

           To open Price Per Square click the   icon the toolbar.
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Getting Started with Price Per Square

  All the numbers supplied with the Price Per Square program are for example only. 

You must enter your own numbers !

Price Per Square contains 4 different tabs        

     

                           

The Total Price Per Square tab manages the other 3 tabs and produces totals based on roof pitch and      

Optionally : Roof removal, Sheathing and Tax .    

  

                                                      

                                                                                                         

You define the headings for different roof types in the top row in this grid.  

Changes made here will be copied to the headings in all grids.

All grids contain different colors of cells to aid in entering your data.

You can enter data in all the light gray and calculator cells.

The white and yellow cells are system maintained.

    

The first time you use Price Per Sq Calculator  enter costs per square  for labor, materials, overhead, roof

removal, cleanup etc.

Select Labor-Tearoff tab at the top of the program. Here you will enter your costs per square for installing roofing

materials, OSB and roof removal. 

   

  Next:

Select the Material Prices tab. Here you enter your material prices per square.

  

  Next:

Select Profit, Overhead tab. Here you will enter your costs for Profit, Overhead and clean up per square. 
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Material Prices

Applies to Price Per Square module

 Material Prices

  See Note below

  Felt Prices Grid

 Enter the description of your felt in the Description column

 Enter the weight of felts in the Weight column.(Optional)

 Enter how many squares a roll of felt covers in the Sqs Per Roll column.

 Enter the price per roll in the Price per Sq column. 

 The Price per Sq and Row columns are system maintained and will show the results of dividing your Price per

   Roll by Sqs Per Roll. 

 The following grids are also updated:

  Material Grid

  The felt row price

  The Total Price row

  Total Price Grid  The Material Price row in Total Price Per Square

   

  Material Prices Grid

Enter prices in the field materials row or click the calculator icon to use a  multi-function calculator to calculate

field materials.

  OSB Material

      

This row is updated by the Price Per Square Program.

  Nails-Staples

 Enter your prices in the nails-staples row. This price can vary depending on nails vs coil nails vs staples and different

lengths.

   Or

 You can change this row to fit your needs

   Loading

  Enter your price for roof loading. (Non-taxable row)

   Or

  You can change this row to fit your needs

   Total Price Materials

  This row is totaled by the Price Per Square Program.

   Note:  

        

 Do not add tax to materials. The tax will be added if the tax option is selected in Total Price Per Square grid.
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Labor Roof- Removal

 All the numbers provided are for example only. You must enter your prices.

Lay Roofing Per Square

  Enter your labor costs per square for each roof pitch. A square of plywood is based on 3.13 sheets per square. 

  Don't forget to add payroll taxes and workman's comp to these prices. You can also add these taxes in optionsoptionsoptionsoptions

when doing detail pricing.

 Roof Removal  Prices Per Square

  Enter your roof removal prices here. If you use a roof removal company, many have a chart or price 

  list similar to this.

You can enter costs in all the gray colored cells.

In the  column named Lay OSB enter how much you pay a roofer to install a square of OSB (3.13 sheets per square).

Enter how much you pay a roofer to install roofing for each roof pitch. 

You may want to add payroll taxes to your costs.

  

Entering your prices for roof removal

Enter your costs for for each pitch and number of layers of roofing to be removed.

If you use a roof removal company, many have a price list similar to this one.

You can also open this Roof Removal price list from your Deta il Pr ice Misc/Other  gr idDeta il Pr ice Misc/Other  gr idDeta il Pr ice Misc/Other  gr idDeta il Pr ice Misc/Other  gr id . Clicking numbers adds

them to your rate column.
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Profit Overhead Cleanup

          

Profit Per Square

  Here you have 3 levels of profit. Usually companies charge more for higher priced material or for jobs that are more

involved. Decide what is right for you.

Overhead per Square

  Here you decide what to charge for overhead. This can vary greatly from company to company.

Insurance, telephones, gasoline etc. has to be accounted for.

Cleanup per Square

  Here again you decide.
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Total Price Per Square

 Selecting or deselecting any Option Buttons or Drop-down Combo-box causes materials and total price

per square to be recalculated and updated.

 Roof Pitch Drop-down Combo-box

   

 By selecting a roof pitch  the following actions take place:

The heading above every grid is updated. 

The prices entered in labor are looked up and added to total per square.

If the roof removal option is also selected then  roof removal price is looked up and also added.

If the sheathing option box is also selected then the plywood labor is looked up and also added.

Tear Off? Option Box

    

When selected  the Layers Drop-down Combo-box is enabled. Prices are

looked up in roof removal based on  Roof Pitch and  Layers and added to Total Price.

 Roof Layers to Remove Drop-down Combo-box

   

Layers of roofing to remove. Selecting anything in this Drop-down 

Combo-box changes the Total Price Per Square.

  Sheathing Option Button

    

When selected  plywood or OSB material is added to Material Prices

and Total Price is updated. Plywood-OSB labor is combined with lay roofing labor and  added to total price.

  Tax?

   

 When selected tax will be added to materials. When entering a tax rate be 

sure to enter numbers correctly eg;   7-1/2 % enter as .075. If you save your work with this selected it 

will be selected the next time you use the program. You cannot enter a tax rate greater than 13%.
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Total Price Per Square Calculations

  Applies to Price Per Square Total Price Per Screen screen.

This table is controlled and updated by the Price Per Square Program. The numbers in this table are not saved 

when saving your work. The one exception is the column labeled ????. In this column  you can enter anything 

you choose and it will be totaled as you type. This column is not affected by Option Buttons or Drop Down Combo

Boxs. Enter numbers for a special  type of work or roof in this column  then save your work These numbers will 

be available the next time you open the program.

  Keep in mind that you can type over the numbers in this table, but changing labor profit, etc or any option 

buttons or combo boxes will over-write changes you have made.
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Naming Column Headings

Enter your descriptions for your types of roofing here.

   Change any column headings in Total Price Per Square and all the other headings are updated

  After making changes save your work.
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Enter Felt Prices

All the numbers provided are for example only. You must enter your prices.

In the description column enter the description for your felt.

In the weight column enter the weight of your felt. (Optional)

In the Sqs Per Roll column enter how many square a roll will cover.

In the Price Per Roll column enter the price for 1 roll.

  The Price Per Square program calculates your felt Price per Square by dividing Price per Roll by Sqs Per Roll 

(Price per Roll / Sqs per roll)

In the last row we want 2 different felts combined together to get our felt per square price.
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Enter Material Prices

   All the numbers provided are for example only. You must enter your prices.

  Price per square 

Do not add tax to your material prices if you have selected the tax option from Total Price Per Square 

   

The first 4 rows in this material grid are taxable rows and tax will be added if you selected the tax option on

materials.

 Row Instructions

 Field Materials  

  Enter your price per square for field materials or Double-click to open a multi-function calculator to aid in calculating

your field material price.

 OSB Material per square row

 This row is controlled by the price per square program. This price is based on the information you provided from 

  Total Price Per Square.

  Felt row

   Click the purple letters in the felt row to drop-down a list of your felts. Select your felt from the list. 

   The felt price will be entered.

  Nails-staples or ?? row 

   You can use this row for any price per square material you want.

 Tax per square row

  This row is calculated by the price per square program.

 Loading row

  Enter roof loading or anything in this row. (Non-taxable)

 Total Price Materials Per Square

  This row is calculated by the price per square program.
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Enter Profit Overhead Cleanup

  All the numbers provided are for example only. You must enter your prices.

  Price per Square Profit, Overhead and Clean-up    

  Row Instructions

  Profit new work-recover row

   Enter your profit per square with-out tear-off or sheathing

  Profit with tear-off row

   Enter your profit per square with tear-off and no new sheathing

  Profit with tear-off and OSB row

   Enter your profit per square with tear-off and new sheathing

  Overhead row

   Enter your overhead per square

  Clean-up row

   Enter your cleanup per square
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Price Per Sq Calculator

  The Price Per Square program has a multi-function calculator that opens by double clicking the  icon

in the top row from the materials tab.  

  You can use this calculator to aid in calculatiing material costs. You can also enter your price directly without

using the calculator.

You can use this calculator for whatever you want, just do click the transfer button.
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Field Calculator

 Price Per Square Field material calculations

The field material calculator can only be opened from this row.

You can enter your field material cost directly into the field material row or double click the cell to open the field

material calculator.

This multi-function calculator supports addition, subtraction, multiplication and division.

  Using the calculator

You can do your calculations by clicking the numbers and symbols or use your keyboard numbers and symbols. 

The following are keyboard equivalents: * = multiplication,  + = addition,   - = subtraction, / = division

   and Enter = "=" , . = "."

To transfer your total, click the transfer button. The total will copied to the cell you opened the calculator from.
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General Purpose Calculator

 This calculator can be used for on the fly calculations. The numbers generated can be transfered to the 

price per program and the Paragraph and Sentence Manager. Click the Copy To Clipboard button to copy the

total to your clipboard. You can paste it anywhere you want.

This multi-function calculator supports addition, subtraction, multiplication and division.

Using the Multi-Function Calculator

   You can do your calculations by clicking the numbers and symbols or use your keyboard numbers and symbols.

 The following are keyboard equivalents: * = multiplication,  + = addition,   - = subtraction, / = division

and Enter = "=" , . = ".".
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Price Per Square Terminolgy

 Terminolgy used in Price Per Square and RoofCalculator

These are called tabs:

This is called a grid:

The gray shaded cells can be edited.

The Price Per Square program contains 6 grids

The grids have titles, cells, columns and rows
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How Price Per Square Totals Numbers

  How Price Per Square totals numbers

We are going to use an example to determine your your Price Per Square

  Example:

Roof Pitch: 6/12

Tearoff: Yes 

Layers: 2 

Sheathing: Yes

Sales Tax: Yes

Take the following steps:

Check the sales tax option    

If you do not want sales tax added to materials skip this step.

Type in your tax rate  

 If you do not want sales tax added to materials skip this step.

 At this point the  program has calculated your materials including sales tax

 Your material price and total price per square in Total Price Per Square have been updated.

Click the roof pitch drop down list, select 6/12 Pitch   

The program looks at your Install roofing per square and updates all the labor prices based on 6/12 pitch

for each material type in total price per square. All the columns in Total price Per Square are then totaled.

Check the tear-off option    

Click the Layers drop down list, select 2 layers    

  The program  gets your roof removal price by looking at your Roof Removal Prices for 6/12 pitch under 2 layers

and copies this price to total price per square to the Roof Removal Row for all materials. All the columns are 

totaled.

Click the Add sheathing option    

The program looks at your OSB price       and multiplies it by 3.13

  The program adds this price to the OSB material row in Material Price. All these columns are then totaled. 

These prices are copied to Total Price Per Square Material-loaded per sq row.

The program then looks at your Labor Grid under the  Lay OSB column , then adds this price to your labor to

install roofing. This price is added to the Total Price Per Square, Install roofing row in all columns.

All the columns in Total price Per Square are then totaled.
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Periodic Maintaince

To keep your prices current in the Price Per Square program, periodic maintaince is required.

Some of the prices will need changing often, others occaionally

The most often would likely be materials.

The most likely of material would be OSB, which can change daily.

Other materials can change daily as well.

Other prices seldom change, such as:

Sales tax

Labor

Overhead

Do what is right for you.

When making changes be sure to save your work.  

Back  up your work to  a  Usb Flash dr iveBack  up your work to  a  Usb Flash dr iveBack  up your work to  a  Usb Flash dr iveBack  up your work to  a  Usb Flash dr ive .
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Copy Prices To Job Cost

  This is only used when in in Per Square Pricing mode

  Clicking any of the blue buttons  will copy the column total price per square and the column heading to the

   Job C ost gr idJob C ost gr idJob C ost gr idJob C ost gr id in RoofCalWriter.

Example:

We will click the blue buttons in the columns titled Hot Mop? and 40yr comp. Notice the results below.

The headings "Hot mop?" and "40yr Comp" were copied. The prices 188.99 and 248.83 were copied and the bid was

totaled.
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Grid Terminolgy

  Grids have column headings, titles, cells, columns and rows.

See also:
Job C ost GridJob C ost GridJob C ost GridJob C ost Grid
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Faq Regristration

    Frequently Asked Questions (click on any link below for our answer, or herehereherehere , to go to all answers)

   Registration FAQ's

   Frequently asked questions for the registration process.

What is  the  dif fe rence between the registered and unregistered ve rs ion ?What is  the  dif fe rence between the registered and unregistered ve rs ion ?What is  the  dif fe rence between the registered and unregistered ve rs ion ?What is  the  dif fe rence between the registered and unregistered ve rs ion ?

How can I  change the  the  registe red to: name in the registered ve rs ion ?How can I  change the  the  registe red to: name in the registered ve rs ion ?How can I  change the  the  registe red to: name in the registered ve rs ion ?How can I  change the  the  registe red to: name in the registered ve rs ion ?

I have  lost my  regristra tion number now what do I  do ?I have  lost my  regristra tion number now what do I  do ?I have  lost my  regristra tion number now what do I  do ?I have  lost my  regristra tion number now what do I  do ?

I keep ge tting "Inva lid regristration number entered" what do I  do  ?I keep ge tting "Inva lid regristration number entered" what do I  do  ?I keep ge tting "Inva lid regristration number entered" what do I  do  ?I keep ge tting "Inva lid regristration number entered" what do I  do  ?

Are  upgrades free ?Are  upgrades free ?Are  upgrades free ?Are  upgrades free ?

C an I use  the  RoofC a lcWrite r program on more  than 1 computer ?C an I use  the  RoofC a lcWrite r program on more  than 1 computer ?C an I use  the  RoofC a lcWrite r program on more  than 1 computer ?C an I use  the  RoofC a lcWrite r program on more  than 1 computer ?

I am evaluating your so ftware  and need more uses, what can I  do  ?I am evaluating your so ftware  and need more uses, what can I  do  ?I am evaluating your so ftware  and need more uses, what can I  do  ?I am evaluating your so ftware  and need more uses, what can I  do  ?

Where  can I  purchase your software ?Where  can I  purchase your software ?Where  can I  purchase your software ?Where  can I  purchase your software ?

C an I ge t C D copy of  the software?C an I ge t C D copy of  the software?C an I ge t C D copy of  the software?C an I ge t C D copy of  the software?

I have  purchased the  software and found it does not fit my  needs, C an I  ge t a  refund ?I have  purchased the  software and found it does not fit my  needs, C an I  ge t a  refund ?I have  purchased the  software and found it does not fit my  needs, C an I  ge t a  refund ?I have  purchased the  software and found it does not fit my  needs, C an I  ge t a  refund ?

  Answers Registration FAQ's

   Answers to frequently asked questions for the registration process.

      Q: What is the difference between the registered and unregistered version ? 

        A: There is no difference the unregistered version has all the features of the registered version.

      Q: How can I change the the registered to: name in the registered version ? 

        A: From the main toolbar click tools, register a form opensform opensform opensform opens  with your delete this name and

          enter a new name. You will need to enter your regristration number.

      Q: I have lost my regristration number now what do I do ?

      A: Email us with your purchase information and we will send a replacement.

      Q: I keep getting "Invalid regristration number entered" what do I do ? 

      A: If you are sure you are entering the number exactly as you recieved it. Then

        the most likely cause is you have downloaded and installed a different program than you purchased.

        Each of our software programs requires a different registration number. Look at the title bar to see

        the name of software you are using. The title bar will reveal the program name and version.

      Q: Are upgrades free ? 

        A:  Minor version upgrades are free. Major upgrades are not free. Registered users can upgrade for

           about 1/2 the price of the new program price. A major version starts with a full number like 6

           a minor version is the full number plus a "." and minor version number. eg: 10.7 The 10 is a major

           version and the 7 is a minor version. Major versions need new regristration numbers, minor 

           versions do not.

       Q: Can I use the RoofCalWriter program on more than 1 computer ? 

       A: You can use the RoofCalWriter program on up to 3 computers.

       Q: I am evaluating your software and need more uses, what can I do ? 

         A: Send us an email at serv ice@roofgenius.comserv ice@roofgenius.comserv ice@roofgenius.comserv ice@roofgenius.com  and will send you a file allowing more uses.

       Q: Where can I purchase your software ? 

         A: Click herehereherehere  to open our buy web page. (You must be connected to the internet) 

       Q: Can I get CD copy of the software? 

       A: Our software is for download only. Email us and we will send a cd, after you have purchased

           our software.

       Q: I have purchased the software and found it does not fit my needs, Can I get a refund ?

       A: Within 30 days after purchase you can get a refund. We will send instructions on the steps

            you need to take.
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Faq Using RoofCalcWriter

 Frequently Asked Questions (click on any link below for our answer, or herehereherehere , to go to all answers)

      Using Program  FAQ's

     Frequently asked questions when using RoofCalcWriter.

Nothing happens when I  c l ick  the  email button, Why ?Nothing happens when I  c l ick  the  email button, Why ?Nothing happens when I  c l ick  the  email button, Why ?Nothing happens when I  c l ick  the  email button, Why ?
Why  am being asked to  enter a va lid email address ?Why  am being asked to  enter a va lid email address ?Why  am being asked to  enter a va lid email address ?Why  am being asked to  enter a va lid email address ?
I opened a saved bid and the templa te  name does not match my  saved estimate , Why  ?I opened a saved bid and the templa te  name does not match my  saved estimate , Why  ?I opened a saved bid and the templa te  name does not match my  saved estimate , Why  ?I opened a saved bid and the templa te  name does not match my  saved estimate , Why  ?
I have a bid saved with 2 pr ices and now I need a  pr ice  on a different mate rial. How ?I have a bid saved with 2 pr ices and now I need a  pr ice  on a different mate rial. How ?I have a bid saved with 2 pr ices and now I need a  pr ice  on a different mate rial. How ?I have a bid saved with 2 pr ices and now I need a  pr ice  on a different mate rial. How ?
Does the RoofC a lcWr iter program handle  b ill ing and payments ?Does the RoofC a lcWr iter program handle  b ill ing and payments ?Does the RoofC a lcWr iter program handle  b ill ing and payments ?Does the RoofC a lcWr iter program handle  b ill ing and payments ?
How do I  de le te  a  b id I  have  saved ?How do I  de le te  a  b id I  have  saved ?How do I  de le te  a  b id I  have  saved ?How do I  de le te  a  b id I  have  saved ?
I want to  subtract a roo f area from my estimate , How can I  do  this ?I  want to  subtract a roo f area from my estimate , How can I  do  this ?I  want to  subtract a roo f area from my estimate , How can I  do  this ?I  want to  subtract a roo f area from my estimate , How can I  do  this ?
I  have a saved estimate  and my customer now wants ridge on rakes, How can I  do this ?I  have a saved estimate  and my customer now wants ridge on rakes, How can I  do this ?I  have a saved estimate  and my customer now wants ridge on rakes, How can I  do this ?I  have a saved estimate  and my customer now wants ridge on rakes, How can I  do this ?
I  saved an estimate with the  wrong pitch, How do I  cor rect this ?I  saved an estimate with the  wrong pitch, How do I  cor rect this ?I  saved an estimate with the  wrong pitch, How do I  cor rect this ?I  saved an estimate with the  wrong pitch, How do I  cor rect this ?
I  have a new computer and all o f my saved bids a re on my  o ld computer, what do I  do  ?I have a new computer and all o f my saved bids a re on my  o ld computer, what do I  do  ?I have a new computer and all o f my saved bids a re on my  o ld computer, what do I  do  ?I have a new computer and all o f my saved bids a re on my  o ld computer, what do I  do  ?
Do I  have  to ente r r idge  and sta rte r per  square  ?Do I  have  to ente r r idge  and sta rte r per  square  ?Do I  have  to ente r r idge  and sta rte r per  square  ?Do I  have  to ente r r idge  and sta rte r per  square  ?
Why  can I  not save a bid with no name ?Why  can I  not save a bid with no name ?Why  can I  not save a bid with no name ?Why  can I  not save a bid with no name ?
Why  am I  a lways being asked to  save  changes?Why  am I  a lways being asked to  save  changes?Why  am I  a lways being asked to  save  changes?Why  am I  a lways being asked to  save  changes?
How do I  uninsta ll RoofC a lcWriter ?How do I  uninsta ll RoofC a lcWriter ?How do I  uninsta ll RoofC a lcWriter ?How do I  uninsta ll RoofC a lcWriter ?
My  Too lbars a re sometimes a different co lor, Why ?My  Too lbars a re sometimes a different co lor, Why ?My  Too lbars a re sometimes a different co lor, Why ?My  Too lbars a re sometimes a different co lor, Why ?
The Pr int P rev iew is  not ava ilable  from the main screen, Why ?The Pr int P rev iew is  not ava ilable  from the main screen, Why ?The Pr int P rev iew is  not ava ilable  from the main screen, Why ?The Pr int P rev iew is  not ava ilable  from the main screen, Why ?

     Answers Program  FAQ's

  Frequently asked answers when using RoofCalcWriter   

            Q: Nothing happens when I click the email button, Why ? 

            A: You cannot send an emailemailemailemail without entering an email address from RoofCalcWriter.

            To send an email from the email program on your computer click File on the toolbar

           and click the email icon. (Short-cut Ctrl+L from the main screen.)

         Q: Why am I being asked to enter a va lid ema il addressva lid ema il addressva lid ema il addressva lid ema il address ? 

            A:  We are only verifying that you have entered the correct syntax. No use in sending an email that 

            has no chance of being successful.

         Q: I opened a saved bid and the templatetemplatetemplatetemplate  name does not match my saved estimate, Why ? 
         A: Your template names can be changed many times and may no longer be in your templates.

             Templates are designed to aid in grouping roof types to produce a fast and easy estimate.

             Once a bid is saved it no longer has anything to do with your templates.

         Q: I have a bid saved with 2 prices and now I need  a price on a different  material.

            How can I save my bid with more than 2 prices?  
         A: RoofCalcWriter is designed to only save 2 prices. As a work-around you could do a couple things.

           1. Open your saved bid and copy your prices to quick bid or copy your prices to Notes. Enter

             your new prices and save your estimate.

           2. Open your saved bid and enter your new prices. Before saving your bid add Bid#2 after the 

              lastname. Like this: John Doe Bid#2. Then you will have 2 different bids.

        

         Q: Does the RoofCalcWriter handle billing and payments ? 
         A: No. You could create folders to distinguish between paid and unpaid jobs. Open your

           saved bid and in Notes type the date billed and amount and then date paid and amount.

           Don't forget to save your bid when making changes.

         Q: How do I delete a bid I have saved ?

         A: Open your saved bids by clicking the "File  openFile  openFile  openFile  open" icon on the toolbar. Select the bid you want

           to delete and press the delete key on your keyboard.

         Q: I want to subtract a roof area from my estimate, How can I do this ? 
         A: For roof  a rearoof a rearoof a rearoof a rea  add a minus sign ("-") in front of one of 2 numbers you are multiplying.

            Like this 47 x -25 = -1125. For addition put a minus in front of your number. like this -26.

         Q: I have a saved estimate and my customer now wants r idge on rakesr idge on rakesr idge on rakesr idge on rakes , How can I do this ? 
         A: Open your saved bid click the ridge on option and it will be added.

           Note: You would probably want to remove the roll starter on rakes if it was selected.

         Q: I saved an estimate with the wrong pitch, How do I correct this ?

         A: Open your estimate, change the pitchpitchpitchpitch  and the totals will be recalculated.

           Note: You may want to change your bid price per squareprice per squareprice per squareprice per square .

         Q: I have a new computer and all of my saved bids are on my old computer, what do I do ? 

         A: Copy all the files under the RoofCalcWriter program to a cd or other media. Install the RoofCalcWriter

             program and then copy your backup to the RoofCalcWriter program. When prompted to overwrite answer

yes. 
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         Q: Do I have to ente r r idge  and sta rte r per  squareente r r idge  and sta rte r per  squareente r r idge  and sta rte r per  squareente r r idge  and sta rte r per  square  ? 

         A: No. If you leave them blank only Roof Area measurments will add to your total squares.

         Q: Why can I not save a bid with no name ? 

         A: If this was allowed you would never be able to find anything

         Q: Why am I always being asked to save changes ?

         A: This is a safe-guard so you do not loose changes or work you have done.

         Q: How do I uninstall RoofCalcWriter ?

         A: From add remove programs  find RoofCalcWriter, click Remove.

             Note: Any estimates you saved will not be removed. 

         Q: My Toolbars are sometimes a different color, Why ?

         A: If you change your Windows system colors RoofCalcWriter will change to match the 3 basic colors.

         Q: The Print Preview is not available from the main screen, Why ?

         A: This by design, our code determines the layout to be able to fit on one page.

 

Frequently Asked Questions Creating Documents

My logo is not on my computer how can I use it to create my headings ?My logo is not on my computer how can I use it to create my headings ?My logo is not on my computer how can I use it to create my headings ?My logo is not on my computer how can I use it to create my headings ?

How can I change the pr ice and wording on a saved proposal ?How can I change the pr ice and wording on a saved proposal ?How can I change the pr ice and wording on a saved proposal ?How can I change the pr ice and wording on a saved proposal ?

How can i change the names in in Document manager , EG: Proposal, Invoice,How can i change the names in in Document manager , EG: Proposal, Invoice,How can i change the names in in Document manager , EG: Proposal, Invoice,How can i change the names in in Document manager , EG: Proposal, Invoice,

    Change Order, Letter and Certif icate ?       Change Order, Letter and Certif icate ?       Change Order, Letter and Certif icate ?       Change Order, Letter and Certif icate ?   

Why am I being warned about proposal and job cost pr ices not matching ? Why am I being warned about proposal and job cost pr ices not matching ? Why am I being warned about proposal and job cost pr ices not matching ? Why am I being warned about proposal and job cost pr ices not matching ? 

Why am i being asked to save a document after  pr inting, when i have made no changes ?Why am i being asked to save a document after  pr inting, when i have made no changes ?Why am i being asked to save a document after  pr inting, when i have made no changes ?Why am i being asked to save a document after  pr inting, when i have made no changes ?

Why are my sentences being removed from my sentence list when i create a proposal ?Why are my sentences being removed from my sentence list when i create a proposal ?Why are my sentences being removed from my sentence list when i create a proposal ?Why are my sentences being removed from my sentence list when i create a proposal ?

Do you consider suggestions for improvements to RoofCalcWr iter ?Do you consider suggestions for improvements to RoofCalcWr iter ?Do you consider suggestions for improvements to RoofCalcWr iter ?Do you consider suggestions for improvements to RoofCalcWr iter ?

Is this the final version of RoofCalcWr iter ?Is this the final version of RoofCalcWr iter ?Is this the final version of RoofCalcWr iter ?Is this the final version of RoofCalcWr iter ?

How do I know if i have the latest version of  RoofCalcWriter?How do I know if i have the latest version of  RoofCalcWriter?How do I know if i have the latest version of  RoofCalcWriter?How do I know if i have the latest version of  RoofCalcWriter?

Are upgrades free ?Are upgrades free ?Are upgrades free ?Are upgrades free ?

How long does it take to get a response to an email ?How long does it take to get a response to an email ?How long does it take to get a response to an email ?How long does it take to get a response to an email ?

What steps do I need to take to save my estimates when upgrading my computer ?What steps do I need to take to save my estimates when upgrading my computer ?What steps do I need to take to save my estimates when upgrading my computer ?What steps do I need to take to save my estimates when upgrading my computer ? 

  Answers frequently asked questions creating documents

         Q: My logo is not on my computer how can I use it to create my headings ? 

         A: You will have to get it on your computer by having it scanned. After you have opened it, copy

          and paste it into the Document Designer program. Or use a Usb Flash Dr iveUsb Flash Dr iveUsb Flash Dr iveUsb Flash Dr ive .

        Q: How can I change the price and wording on a saved proposal ?

        A: Open your proposal make your changes and save it. It will replace your old proposal.

        Q: How can i change the names in in Document manager , EG: Proposal, Invoice,

        Change Order, Letter and Certificate ?  

        A: These cannot be changed. 

        Q: Why am I being warned about proposal and job cost prices not matching ? 

        A: If you save an estimate with different prices in your proposal and your Job Cost

        grid will you later know the correct price?

        Q: Why am i being asked to save a document after printing, when i have made no changes ? 

        A: By saving at this point you are also updating the Document manager grid to indicate that it has

         been printed and the printed date. If you decline you will not lose your document.

        Q: Why are my sentences being removed from my sentence list when i create a proposal ?

        A:   Your sentences are removed to avoid adding duplicates. Click the refresh button to reload your list.

        Q: Do you consider suggestions for improvements to RoofCalcWriter?

        A: We welcome suggestions. The more input we get the better we can improve our software.

           Just added Ideas-RecommendationsIdeas-RecommendationsIdeas-RecommendationsIdeas-Recommendations .

        Q: Is this the final version of RoofCalcWriter ?

        A: No, we consider RoofCalcWriter an ongoing project with many features planned for the immediate

         future and many more further down the road.

        Q: How do I know if i have the latest version of  RoofCalcWriter ?

        A: Click the help text on the main toolbar, then select about. You will see the version number. 

          Compare this version number with the version number here: http:roofgenius.com/download.asphttp:roofgenius.com/download.asphttp:roofgenius.com/download.asphttp:roofgenius.com/download.asp

          The higher the version number the newer the program.
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        Q: Are upgrades free ? 

        A: Minor version upgrades are free. Major upgrades are not free. Registered users can upgrade for

         about 1/2 the price of the new program price. A major version starts with a full number like 6

         a minor version is the full number plus a "." and minor version number. eg: 10.4 The 10 is a major

         version and the 4 is a minor version. Major versions need new registration numbers, minor versions do not.

         Q: How long does it take to get a response to an email ?

         A: We feel promptly responding to emails is very important and should never take longer than 4 hours.

            We will never take more than 8 hours.

        Q: What steps do I need to take to save my estimates when upgrading my computer ? 

        A: Save all the files under the RoofCalcWriter program to a Cd or other media. If you no longer have the

          original RoofCalcWriter setup program then download it from our website.  After you install the program

          copy the files from your backup media to the RoofCalcWriter program. See Usb-BackupUsb-BackupUsb-BackupUsb-Backup

 Back to the topBack to the topBack to the topBack to the top
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Cell Viewer

  Using the Cell Viewer 

The cell viewer aids you in entering data into the Job Cost Grid.

Open the cell viewer by clicking the icon on the Job Cost Grid.   This Cell information window can

be dragged to any position and it will be remembered.

 Clicking any cell in the Job C ostJob C ostJob C ostJob C ost grid updates the cell viewer giving complete information on the selected

cell. The lines in the roof plan change to red depending on the cell clicked.

Examples:

Here we have selected the first cell in the first row. This row totals the roof area. Notice the red lines on

the roof diagram and the red text explaining the purpose.

 

 Here we have selected the first cell in the 2nd row. This row totals the hips + top ridge. Notice the red 

lines outlining the top ridge and hips.

 

  Here we have selected the cell used to enter your price price per square. Notice all the lines on the 

roof plan are black.
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Cell Information Window

The Cell Information widow is used to provide guidance in editing the Job C ost GridJob C ost GridJob C ost GridJob C ost Grid.

 Open this Cell Information window by clicking the   icon on the Job Cost Grid.

 You can click any cell in the Job Cost grid and this provides information on the cell.

The roof plans lines will turn red indicating the cell purpose. Any of the first 8 rows updates

the roof plan. The red text changes to provide information on each cell.

   

This window can be dragged to any location and it will be remembered and be in that position 

the next time you open it.

More  infoMore  infoMore  infoMore  info
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Total Price Per Square Window

See Also:
Labor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  Window
Material P r ices WindowMaterial P r ices WindowMaterial P r ices WindowMaterial P r ices Window
Profit,  Overhead, C lean-up WindowProfit,  Overhead, C lean-up WindowProfit,  Overhead, C lean-up WindowProfit,  Overhead, C lean-up Window
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Labor Tearoff Window

See Also:
Total Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  Window
Material P r ices WindowMaterial P r ices WindowMaterial P r ices WindowMaterial P r ices Window
Profit- Overhead-C leanup WindowProfit- Overhead-C leanup WindowProfit- Overhead-C leanup WindowProfit- Overhead-C leanup Window
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Material Prices Window

Applies to Detail Pricing Mode Only

See Also:
Total Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  Window
Labor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  Window
Profit,  Overhead, C leanup WindowProfit,  Overhead, C leanup WindowProfit,  Overhead, C leanup WindowProfit,  Overhead, C leanup Window
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Profit Overhead Cleanup Window

 See also:
Total Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  WindowTotal Pr ice Pe r Square  Window
Labor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  WindowLabor-Tear-Off  Window 
Material P r ices WindowMaterial P r ices WindowMaterial P r ices WindowMaterial P r ices Window
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Document Designer Quick Start

Creating documents consists of 3 main screens.

 1.  RoofCalcWriter Main Screen.

  This where you will information about your document such as customer name, address and prices.

2. Paragraph and sentence manager  

Create your sentences and paragraphs for your proposal.

3. Document Designer   
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Using the Document Manager

Use the Document Manager to create new documents and view your saved documents.

To open Document Manager click the   icon on the RoofCalcWriter main toolbar.

When creating a Proposal click the    to have the price copied into the Amount

column from the Job Cost Grid.

By clicking the  icon the proposal price will copied to the amount column. If you

have a price in the change order amount column it will be added to the proposal price.

The Date column tracks when each document was created and saved.

The Printed column lets you know the document has been printed. By moving your mouse over

over the blue check marks will give you the date printed.

Clicking any of the blue buttons in the Create/See column displays a saved document

or allows you to create a new document if no document has been saved.

This form can be dragged to any location and it will be remembered the next time you use it.
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Enter Text As A Picture

Most windows and email programs when you enter a picture the whole row is as high as the

picture. Only one line of text can typed into that row leaving a lot space the height of the image.

In fact this help file maker behaves just that way.

  Place your cursor at the location you want your text-picture located then click this button   

 on the Document Designer toolbar. A dialog opens where you can write and format text.

 Entering text as a picture allows you to format text and enter it next to a picture or logo.

Enter and format your text into this dialog, the click the arrow and your text will be entered 

into your document at your current cursor location.

     

   These are 2 pictures side by side.
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Creating Custom Headings

Click the design button on the RoofCalcWriter toolbar to open Document Designer  

If you are creating from  scratch decide how you want your heading layed out.

Use the new screen capture cameracameracameracamera   to get parts or whole images from anywhere on your computer. 

 Considerations

Do you want to use a logo?

Do you want your contact information under, over or to the right side or the left side or ?

The RoofCalcWriter program allows you to insert pictures from a toolbar button or dragging from

another program or just pasting.

Do you want to add a slogan ?

Do some experminting, images you enter can be resized by dragging the borders.

View Toolbar Commands herehereherehere.
View Menu commands here.here.here.here.

 Use all the text formating and image toolbar buttons and menus at your disposal to make your heading just the
way you want it.

Some examples:

  

    

After you have created your heading copy it to the other 4 documents by copying and pasting.

Be sure to save your work often.
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Tool Bar Buttons

  For the Main Screen toolbar buttons click herehereherehere .

These toolbar buttons are avaiable thru Paragraph and Sentence and Document Designer. Not all toolbars 

contain the same buttons.

Most of the toolbar buttons are standard text picture formating windows buttons. We will explain each

button below.

All the Tool and Format commands can be accessed thru the menus.menus.menus.menus.

Toolbar Buttons

The Paragrah and Sentence Toolbar

The Document Designer Toolbar

    Takes you back to RoofCalcWriter main screen.

    Copies selected text or selected picture to the clipboard.

    Pastes text or pictures from the clipboard.

   Erases and copies selected text or selected picture to the clipboard.

   Deletes selected text or pictures.

     Print Preview

      Opens help

   Prints the current document.

  Undo or redo your last action.

  Spell check the current document.

  Insert a picture.

  Format and insert Date and/or time. 

  Insert text as picture.

  Insert a table.

  Email created documents as attachments.

  Capture a picture.

The Format Toolbar Buttons

          Turns selected text bold on and off.

         Makes text italic.

        Underlines text.

           Left aligns pictures or text

          Center aligns text or pictures.
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                  Right aligns text or pictures.

     Make a bulleted list .

Format Painter, Copies selected text formating to other text. Example: if you have some bold red text, selected

it, click the paint brush,

              then select the text you want to be red and bold. It copies the red and bold not the actual text.

  Highlights  

          Colors selected text.
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Writing Body Text

 The wording in the documents we have provided is for example only.

When writing the content for your proposal we advise you to have an attorney look it over.

All the documents contain example text and placement markers. The placement markers can be

identified by a pound sign (#) next to a word. The words are pretty self explantory, for a list of

these markers with their meaning click herehereherehere.

These markers can be moved and placed where you want, but cannot be deleted. These markers

are used by the RoofCalWriter program for placing information when you create documents.

  Example:

 When creating a document the RoofCalWriter program scans the document and finds the #name 

marker. It then places your customers name at that place. The rest of the document is scanned for

#tags and the appropriate information is entered.
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Spell Check

 Spell Check allows you to avoid embarrassing spelling mistakes. Spelling without mistakes

and typos is especially important , to make a good impression in business communications,

to get sales and close deals.

Click the   icon  on the toolbar. A dialog opens and your document is scanned.

Mispelled words are highlighted. You can ignore the suggestion, change the word to the suggested 

word in the change to box, or add it to your dictionary. Company names and special text

should be added to your dictionary to keep them from repeadly be selected.
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Creating and Using Sentences

To get started making your sentencess click this icon on RoofCalcWriter toolbar 

Create sentences before paragraphs

    Creating your sentences before your paragraphs allows you to use your sentences to

make your paragraphs.

 By creating sentences you save time by being able to add specific items to your proposal that

are not in your paragraphs.

 We have provided a few sentences for example purposes. You can delete or edit these sentences.

The sentences dialog works in 2 modes:

1.  Edit mode for creating sentences.

2. Insert mode for using your sentences to make paragraphs and create proposals.

To create sentences click the edit option. Type the description in the box provided and click save.

You can create an unlimited number of sentences.

To delete a sentence select it from the list and click the Delete button.

After you have created your sentences click the Insert option to change the mode.

Click the  to drop your list of sentences, by clicking the sentences they are added either to

the end of a paragraph (if you have one open) or directly into the main window. Each sentence 

clicked is added directly below the last one added. (See note below)

Each item selected is removed from your list of sentences as to avoid duplicate entrys. 

You can reload your list by clicking the refresh button. 

Note:  

If you have selected the add sentences to cursor, your senteces will not be added to the next line after your

paragraphs.  

The sentences will be added to your cursor location.

See:  Adding sentences to cursorAdding sentences to cursorAdding sentences to cursorAdding sentences to cursor
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Create and use Paragraphs

To get started making your paragraphs click this icon on RoofCalWriter toolbar   

Create sentences before paragraphs (shortcut)

    You can make your paragraphs by typing sentences or by using the sentence manager.

Creating your sentences before your paragraphs allows you to use your sentences to

make your paragraphs.

 Creating predefined paragraphs of roofing procedures or tasks allows you to create 

proposals with just a few clicks. Paragraphs work like this:

You enter a price in the main RoofCalculator in Document Manager

  

Click the blue button and your proposal will open with the price inserted into your #price marker.

Select your paragraph from the dropdown list. It will scan your proposal and find this tag: #paragraph_marker.

Your paragraph will be inserted at this marker. You can then type sentences or select sentences to be added

 from the sentence manager. By clicking sentences from the sentences combo they are added to the end of

your paragraph. (see note below)

 We have provided a few paragraphs for example purposes. You can delete, edit or change the titles

 and/or the wording of these paragraphs.

 

Note:  

If you have selected the add sentences to cursor, your senteces will not be added to the next line after your

paragraphs.  

The sentences will be added to your cursor location.

See:  Adding sentences to cursorAdding sentences to cursorAdding sentences to cursorAdding sentences to cursor
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Emailing Documents

You can email anything you want from the Sentence And Paragraph screen by clicking 

the email icon on the toolbar.  The email program opens with the attachment field

filled in. 

You can also optionally set emails to be included in the body rather than as an attachment.

This setting is set in options.

 If you have prevously setup your email program, just click the send button.

Your document will be emailed as an attachment with the attachment name as

the  customers last name and address  + document and the .jpg extension.

Like this:  CustomerName address + Proposal.jpg

Or this: CustomerName 1124 Oak Ave Invoice.jpg

If your document is created by company name then the file name would be document

type name + CompanyName + Job Address + document .jpg extension.

Like this: CompanyName job address + Proposal .jpg

Or this:  CompanyName job address + Invoice.jpg

These emailed documents are  saved to a folder called "Emailed Documents". We recommend you check cc to

sender all your

emailed documents, so a copy is always emailed to you. 

The following information is automicatlly saved, when emailing and provided for your next email.

 Sender Name

 Sender Email

 Cc to Sender

Smtp settings

Smtp server

Username

Password

Port #

Starttls number

You can view thumbnails of emailed documents at any time from the email program by clicking this button :

Viewing emailed documents.V iewing emailed documents.V iewing emailed documents.V iewing emailed documents.
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Recent File List

The recent file list provides a convient way to open the last files you have opened or created.
The most recent will be at the top of the list.

Click File from the toolbar a list like this will drop down, Click  

Click any of the names from the Recent files to open your files.
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Internet Connections

Our software does not need a connection to the internet to operate,

You will need an internet connection to Email documents or to check for program updatesprogram updatesprogram updatesprogram updates .

Common Internet connection problems.

You can connect
Our software will not connect but you can surf the web and go from page to page.
This usually means a fire-wall or anti-virus is blocking you. This is not a bad thing, as that is what they are supposed
to do. Look
first at your firewall, then your anti-virus. Configure them to allow our software. We do not recommend you turn them
off.

You cannot connect

How to Troubleshoot Your Internet Connection for DSL or Cable Service
For Dialup go hereFor Dialup go hereFor Dialup go hereFor Dialup go here

One of the common problems among internet users is testing their internet connection to pinpoint the exact problem.
There is a big number of internet users who use DSL, and cable modem service.

You set up your connection the way your ISP (internet service provider)instruct you to. Sometimes, it doesn't work for
numerous reasons.

You service is not ready, your hardware in not connected properly, or your ISP is having problems.

Whatever the cause of the problem maybe, there are some diagnostic tools you can use in Windows XP, in order to
identify the problem.

If you are not exact in your diagnostic, you will get a good idea at least.

Before we get to the diagnostic tools, let us discuss what is involved in an internet connection.

The information travels over the internet to your computer through your ISP service. This is done through a High speed
modem then to a network card installed in your computer.

Your computer is called a host, your service provider will give you the DNS IP address, and you get your login and
password. That is all what you have from your ISP.

Sometimes, your internet connection fails, and you want to find out the problem. You may be able to fix it, or at least
get some information about the problem to advise your isp for help.

You will start by accessing the command prompt by going in sequence to:

Start menu, program, accessories, then command prompt. A window will open where you type commands from the
prompt.

At the command prompt, you type: IPCONFIG. This command will give you the active network connection on your
computer. Here is an example:

PPP adapter Copy :

Connection-specific DNS Suffix . :
IP Address. . . . . . . . . . . . : 68.239.158.45
Subnet Mask . . . . . . . . . . . : 255.255.255.255
Default Gateway . . . . . . . . . : 68.239.158.45

The above output was produced when I ran the Ipconfig command on my own computer running Window XP OS, and
A DSL connection. The IP address is my computer address assigned by the ISP.

Please note, you can add an option to this command, in order to get more detailed information about your
connection. Here is the output, when I ran the same command with the "all" option.

Ipconfig /ALL

PPP adapter Copy :

Connection-specific DNS Suffix . :
Description . . . . . . . . . . . : WAN (PPP/SLIP) Interface
Physical Address. . . . . . . . . : 00-53-45-00-00-00
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Dhcp Enabled. . . . . . . . . . . : No
IP Address. . . . . . . . . . . . : 68.239.158.45
Subnet Mask . . . . . . . . . . . : 255.255.255.255
Default Gateway . . . . . . . . . : 68.239.158.45
DNS Servers . . . . . . . . . . . : 151.198.0.39 151.197.0.39 NetBIOS over TCP/IP. . . . . . . . : Disabled

Notice now, the output includes the phisycal address of the network interface card installed in my computer. Also,
you see the DNS IP addresses. With the above information, I didn't have any problems.

Supposed ,I disconnect my DSL connection and ran the command again, this is the new result:

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . :
IP Address. . . . . . . . . . . . : 192.168.0.1
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . :

Notice in this case, where I disconnected my connection, you don't get a DNS server. This tells you that I am not
connected to the internet.

Also, notice the IP address starts with 192.168, which is the default address whenever your computer is not
connected to the internet.

Another command is the ping command. It will allow to check if a computer is connected to the network and ready to
communicate, whether intranet, or internet.

Once you run it,it will sent a packet to the computer specified and gives the time it took for the packet to travel. This
is an a output when I tried to ping www.yahoo.com:

C:>ping www.yahoo.com

Pinging www.yahoo.akadns.net [216.109.118.66] with 32 bytes of data:

Reply from 216.109.118.66: bytes=32 time=35ms TTL=55
Reply from 216.109.118.66: bytes=32 time=39ms TTL=55

Ping statistics for 216.109.118.66:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:
Minimum = 35ms, Maximum = 39ms, Average = 38ms.

That shows that the host was reachable, and connected to the internet.

A very important command is the Nslookup. This will let you check if DNS (domain name server) is working properly.
The function of the DNS server is to translate ip addresses to domain name of the networked computer. Here is an
example:

C:> nslookup www.yahoo.com
Server: home5.bellatlantic.net
Address: 151.198.0.39

Non-authoritative answer:
Name: www.yahoo.akadns.net
Addresses: 216.109.118.67
Aliases: www.yahoo.com

So, you enter the name after Nslookup, it will give you IP addresses and vice versa.

In summary, there more commands in Windows Xp, but using the three above commands should give you a good
idea about your internet connection problems. You can find where the problem is occurring. Is it your machine, or the
ISP.

How to Troubleshoot Your Internet Connection for Dialup

You will need to know if the problem is your modem or something else that’s keeping you from connecting to the
Internet. Plenty of problems can keep your computer from getting online, including your phone line itself. When you
pick up your phone, do you hear static, hissing, or crackling? It’s called “line noise,” and it can prevent modems from
connecting or keeping a connection active. (We’ll discuss line noise in more depth below.)
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Bad weather can also give your modem the blues, because rain and excessive humidity can introduce noise into an
otherwise normal phone line. Adapters, line splitters, and cable extenders can do the same.

Have you tried a different phone jack? If you can keep a connection on one jack but not another, there’s a good
chance the problem is the jack itself, or frayed wires inside it. Try removing the phone jack’s wall plate and looking
inside; if you see exposed copper or old, decaying plastic, you may have found the root of your connection woes.

Even software can prevent you from getting online, or staying online once you’ve established a connection. Some
software, such as Microsoft Outlook and Outlook Express, can disconnect your call after you send and receive email.
In Outlook, click Tools, Options, Mail Setup, and uncheck the box marked Hang Up When Finished With A Manual
Send/Receive.

You should also consult your firewall’s users guide for issues that mask themselves as modem problems.

Problem: I can’t get the modem to connect.

Solution: Let’s start with the basics. Does your modem have the most up-to-date software, including drivers and
firmware? Drivers are programs that let your modem communicate with your system. Firmware is software that
resides on the modem itself and governs how the device acts. Both can be flashed—that is, updated with a download
from the manufacturer’s Web site. So before you do anything else, find a computer with an active Internet connection,
get online, download an update if one exists, and copy it to a floppy diskette or burn it to a CD. The Web site should
tell you how to install it.

If your modem starts a call and only gets halfway through the handshake—the loud, high-pitched noise that indicates
your modem is connecting to a computer on the other end of the line—open the Device Manager and click the plus
sign next to the word Modems, then right-click the modem you're using and choose Properties. Click the Advanced
tab, and then click the Change Default Preferences button. Set the number in the Cancel The Call If Not Connected
Within box to 180 or even 240 seconds (the default setting is 60). Click OK twice to return to the Device Manager,
then close the Device Manager and try to connect again.

 

Most analog modems are internal modems that look similar to the one shown above. Note the phone jacks that allow
you to plug your modem directly into your phone’s wall outlet.

Still no luck? Sometimes it helps to add special commands to your modem’s initialization string (a special set of
numbers and letters that tell the modem how to connect to a computer on the other end of the call). The commands
you’ll add are text strings themselves, such as S95=1+MS=11 or &KO. To find them, check the Web site of your
modem’s manufacturer or search the large database at www.ModemHelp.orgwww.ModemHelp.orgwww.ModemHelp.orgwww.ModemHelp.org for your modem’s make and model.
When you’ve found the string you’d like to try, first open the Device Manager, right-click your modem, choose
Properties, and click the Advanced tab. Enter your commands in the box named Extra Initialization Commands and
try to connect again.

If that fails, line noise or faulty hardware in the modem could be to blame. There’s no fix for faulty hardware; only a
replacement modem will do. If you checked for line noise before getting started, keep in mind that modems can
detect far more noise than the human ear. Call your phone company and tell them you think you have a noise
problem that’s preventing your modem from connecting; they can test the line from their office or send a specialist to
your house to tweak line settings such as gain control—that is, how much their equipment boosts your phone line’s
signal, adding noise in the process.

Problem: The modem connects, then drops the call.

Solution 1: If you can get a connection but can’t keep it, try everything in the step above, as it applies to this problem,
too. Remember that certain software (email programs are constant offenders) can disconnect your call after
performing key functions.

If your call disconnects after 10, 20, or 30 minutes, call your ISP (Internet service provider) and ask if they use a
heartbeat message for incoming modem calls. A heartbeat is a small signal sent from the ISP’s server to your
computer, to see if your machine is still active. If not, the ISP will disconnect you, to keep its lines open and save
money. You can also download freeware or shareware that sends regular data packets to your ISP to defeat
heartbeat systems. One well-known program for this is Stay Live 2000 (www.gregorywww.gregorywww.gregorywww.gregory
braun.com/StayLive.html).

Solution 2: Do you have call waiting? If so, incoming calls may force your modem to drop a connection. Your phone
company can tell you how to disable call waiting prior to placing a modem call; often, it’s as simple as pressing #43#
on your phone.

Solution 3: If that fails to work, you should turn off your modem’s data compression feature. Open the Device
Manager, right-click your modem, choose Properties, then click the Advanced Tab and the Change Default
Preferences button. In the Data Connection Preferences section, set the Data Compression menu to Disabled, then
click OK twice to return to the Control Panel. Close it, reboot your system, and try your connection again.
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Solution 4: If the problem continues, try connecting at a lower speed. The higher your connection speed, the less
stable your call. To change your connection speed, open the Device Manager, right-click your modem, choose
Properties, then click the Advanced Tab and the Change Default Preferences button. In the Data Connection
Preferences section, set the Port Speed to a lower number and try to reconnect. Repeat the process if the problem
persists, choosing a lower number each time. You can also click the Advanced Port Settings button on the Advanced
tab and set both the Receive and Transmit buffers to their lowest options. If that fails to work, uncheck the Use FIFO
Buffers option and try to reconnect.

If your modem continues to drop calls, call your ISP’s help desk or the support line at your modem’s manufacturer.

Problem: The modem’s download speed is extremely slow.

Solution: Does your connection slow to a crawl? Are you a year older when a page loads? If so, remember that
analog modems aren’t the fastest connections around. DSL and cable boast speeds up to 50 times faster, and
sometimes more.

What’s more, even a 56K modem won’t connect at 56K. Speeds in the 30 to 50Kbps (kilobits per second) range are
far more common, given problems with phone lines, line noise, and modems themselves. In fact, when computer and
modem makers say “56K,” what they mean is “56K under ideal conditions that don’t exist outside our labs.” Problems
that keep your connection from achieving its fastest speed include your distance from the phone company’s switching
station and whether your neighborhood or apartment building has a concentrator (a device that converts analog phone
lines into digital signals).

Last, your DNS (Domain Name System) and DUN (dial-up networking) settings can add molasses to your modem.
Rather than tweak them yourself, it’s best to call your ISP’s help desk, explain the problem, and ask them for
guidance, as the settings they recommend may depend on the configuration of their internal systems.

 

To find out your modem’s name, model number, and manufacturer, open the Windows Device Manager and look in
the Modems section.

Problem: My modem’s “handshake” process goes on and on and on but never connects.

Solution: The handshake—the loud, high-pitched noise that indicates your modem is connecting to another computer
—is a key step in the connection process. It helps your modem identify connection settings and error correction rates
(error correction lets your modem deal with a change in the quality of the phone line’s signal without disconnecting
the call).

There are two types of error correction: hardware and software, of which hardware is far and away the best. Check
your modem’s users guide to see which type of error correction you have. If it’s software, consider buying a different
modem, as software-based error correction can slow down data rates drastically.

If your modem’s error correction feature is hardware-based, update your firmware using the directions outlined above.
Old firmware is a common cause of long handshakes.

Problem: When I try to connect, I’m told there’s no dial tone.

Solution: Have you checked the phone line itself? If your phones get a dial tone but your modem doesn’t, check your
modem’s connection to the wall jack. Make sure it’s tight. If you have an external modem, check your modem’s
power cable and power supply. If they all check out, you may have too much line noise in your connection, or your
modem itself may need to be replaced.

Problem: When I try to connect, I see a message that says “A dial-up connection could not be established” or “The
protocol is not configured.”

Solution: You may have a problem with your network protocols. A protocol is simply a convention used to govern the
connection between devices. Common protocol names are TCP/IP (Transmission Control Protocol/Internet Protocol),
IPX/SPX (Internetwork Packet Exchange/Sequenced Packet Exchange), and Client for Microsoft Networks. Different
ISPs use a different blend of protocols to let your modem connect to their machines; if you receive an error message
that mentions protocols, call your ISP’s help desk to see which protocols they use, then turn off extra protocols that
can interfere with a connection. (Often, your ISP won’t need the IPX/SPX protocol, which Windows turns on by
default.)

To turn off a protocol, click Start, Control Panel. Double-click the Network Connections icon and right-click your
modem’s dial-up connection. Choose Properties from the context menu. In the section named Use These
Components With this Connection, click the Networking tab and uncheck the box next to any protocol you don’t
want. If you need to add a protocol, click the Add button and select your protocol type from the list. Then follow the
prompts to add it to your system.
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If all else fails, call your ISP’s help desk again and report the problem in detail. Often they’re a better source of advice
than your modem’s manufacturer because they deal with modem problems day in, day out, all year long. With some
luck you’ll get your problem fixed and be surfing in no time.
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Camera Details

From the RoofCalcWriter Main Screen

Bonus Floating Camera allows you to detach the camera from RoofCalWriter and float it above all windows.
You can then capture anything on your screen and paste it into any program that accepts images. 
The floating camera can only be opened from the main screen.

Comments:

Closing the RoofCalWriter program closes the camera.
You can minimize RoofCalcwriter program to move it out of your way.
Closing the camera restores the RoofCalcWriter program. (If minimized).
Paste pictures into your emails, Excel, Powerpoint, Word etc.

   From the Document Manager and the Paragraph and Sentences Screens.

The screen capture allows you to copy any rectangular portion of the screen to the windows clipboard and or
directly into your current document at your cursor location.

You can start the capture three ways:
1.Click the camera icon on the toolbar   .

2 From the insert menu   .

3.The keyboard shortcut keys  Ctrl+N to the clipboard only. Ctrl+D, Copies to the clipboard and into your document.

When starting your capture your mouse pointer turns to a cross   . After finding your starting point press and hold

your
left mouse button and drag around the area you want to capture a dotted outline appears. Release the left button and
your
image will be in your document and on the windows clipboard or optionally just the clipboard.

This tool can be used on more than the RoofCalcWriter program. Get anything you can see on your screen. Below we
have captured the Google logo from the Internet directly into our document. This image could have also been pasted
into any image or picture program or your email program.
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Document Formating How Do I ?

The features listed below are not available from all screens. 

Highligt Tex tHighligt Tex tHighligt Tex tHighligt Tex t  
Change  RulersChange  RulersChange  RulersChange  Rulers
Word WrapWord WrapWord WrapWord Wrap
C reate  a TableC reate  a TableC reate  a TableC reate  a Table
Superscr ipt/Subscr iptSuperscr ipt/Subscr iptSuperscr ipt/Subscr iptSuperscr ipt/Subscr ipt
How to  set/move/remove tabs on the rulerHow to  set/move/remove tabs on the rulerHow to  set/move/remove tabs on the rulerHow to  set/move/remove tabs on the ruler
Pr int Page SetupPrint Page SetupPrint Page SetupPrint Page Setup
Paragraph FormattingParagraph FormattingParagraph FormattingParagraph Formatting
Word Wrap OptionsWord Wrap OptionsWord Wrap OptionsWord Wrap Options
The Ruler  Bar and Page Set-UpThe Ruler  Bar and Page Set-UpThe Ruler  Bar and Page Set-UpThe Ruler  Bar and Page Set-Up
Use the  P icture C ameraUse the  P icture C ameraUse the  P icture C ameraUse the  P icture C amera
Insert a p ictureInsert a p ictureInsert a p ictureInsert a p icture
Using the Format Pa inte rUsing the Format Pa inte rUsing the Format Pa inte rUsing the Format Pa inte r
Inserting C haracte rsInserting C haracte rsInserting C haracte rsInserting C haracte rs
Inserting dates and/or timeInserting dates and/or timeInserting dates and/or timeInserting dates and/or time
Using Quick SquaresUsing Quick SquaresUsing Quick SquaresUsing Quick Squares  
Using the Multi-Function C a lculatorUsing the Multi-Function C a lculatorUsing the Multi-Function C a lculatorUsing the Multi-Function C a lculator  

HighLight Text   

From the format menu:     From the Format Bar      

 The Highlight Tool is designed to display a background color on
selected text. The last color you used for highlighting is visible. To use the last color click the color,
To change to another color click the paint icon.
To highlight choose the Highlight option from the Format menu or click the Highlight tool
button on the Format bar. A color option box will appear. Choose the highlight color you wish.
If you already had text selected the background color of that text will change to the color you
choose. If no text was selected then text you now type at the cursor location will have the
background color chosen.

To remove highlight:

If highlighting was your last action, click the undo button or Ctrl-Z or   from the edit

menu.

If highlighting was not your last action, click the paint icon and select the white color as your highlight color.

How To Change Measurements: inches or centimeters.

 RoofCalcWriter gives you the choice of setting your document measurement in inches or centimeters.
 To change measurement select Ruler Measurement from the View Menu. From the Ruler Measurement 
 sub-menu choose inches or centimeters.

Your choice will be remembered by RoofCalcWriter and will displayed each time you start the
program until it is again changed. The measurement of choice will be displayed in settings
displayed in the Page Setup, Paragraph and Tab dialog windows. The ruler will also change to
the measurement selected. More ..More ..More ..More ..

Word Wrap:  There are three choices of Word Wrap. 

1. Wrap to Ruler:  This usually is the best choice since the result is basically a WYSIWYG (what you see is what
you get) screen display.
  This means that the screen display is basically the same as how the document will be printed.
2. Wrap to Window:  Does what it says. Text paragraphs that do not have a hard carriage return/line feed will expand
and contract based on
the size of the viewable window.
3. No Wrap:  Not sure why anyone would choose this option.  Basically it means a paragraph is displayed in one,
long, line.  The arbitrary width 
of the rich text box in no wrap mode is 200,000 twips which is almost 140 inches. More..More..More..More..

How to Create A Table:   

  Gives you the ability to quickly insert simple tables.
 From the Format menu, choose the Table... menu or click the table icon on the toolbar.
 A window appears where you set the number of rows, columns, column width(s), and also an 
option for the table to be centered.
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If you want all columns to be the same width then enter, in inches, the desired width. If the
columns are to be of varying widths, click the selection button and enter the widths of each
column as prompted. When finished click OK and the table will be displayed at the cursor
position in your document. You may then enter the desired text in your row and column cells.
   More ..More ..More ..More ..

How to use Superscript/Subscript:   

The superscript/subscript tool allows you to offset selected text. Superscript places text above
the current line while subscript will place text below the current line. You can create special text
effects using this tool:
The easiest way to use this tool is with the assigned shortcut keys.
Step 1: Select the character or word you wish to superscript or subscript.
Step 2: Press Shift + F7 to superscript or Shift-F8 to subscript the selection.
Step 3: Each key press will offset the selection by about 2pts. Continue pressing the key
choice until the selected text is at the desired position.
Alternatively you can use the Superscript/Subscript menu option. From the Format Menu
choose Attributes... and then from the sub-menu choose Superscript or Subscript.

 How to set/move/remove tabs on the ruler: 

You can set tab stops by left clicking the ruler at the location where you wish to set a tab.
This will insert a tab indicator that looks like this:  

 Move set-tabs by pressing the left mouse button on the tab indicator and dragging it to the
location you wish.
To delete tabs, right click on the tab indicator. The tab dialog will pop-up and you can remove
an individual tab or clear all tabs for the paragraph.
Alternatively you can set, move or delete tabs for a selected paragraph by choosing the Tab
option in the Format menu. More ..More ..More ..More ..

Print Page Setup:

Choose the Page Set-Up option from the File menu. A window dialog will appear on
your screen. From this window you can choose the paper size/type, orientation, and margins.
The settings you enter here will apply to the whole document.
There are several different paper sizes from which to choose including A4, Letter, Legal and
various envelopes. Letter is the default paper size.
 Margins: By default, all margins are set to one inch (25.4mm). The minimum margin that
can be set is .25 inches. A header or footer displays at .25 inches from the top and bottom
respectively. If your margins are less than .50 inches these may not display correctly.
 Headers and Footers: Page Set-Up is also where you may create a header or footer for
your document. While the header and footer will not be visible on screen they will appear
on every page of your printed document. A header or footer displays at .25 inches from the
top and bottom respectively.
We use special ampersand codes to display special text in headers and footers. The ampersand
codes are &l, &c, &r, &f, &d, &t and &p. The &l, &c, and &r codes are for alignment (left,
center, right), &f will print the filename, &d today's date, &t the time and &p the page number.
You can also combine those with words. For example &c Page: &p will print the word " Page: "
followed by the current page number centered on the page. A maximum of 60 characters may
be displayed in a header or footer.More..More..More..More..

Paragraph Formatting

While margins for the entire document are set from the Page Set-Up window, you can
modify left and right indent margins and the alignment of each individual paragraph.
Step 1: Click anywhere in the paragraph you want to format.
Step 2: On the Format menu, click Paragraph.
Step 3: Under Indentation, type a measurement of how far to indent the paragraph.
• You can indent all of the paragraphs in a new document by changing the format options
before you begin to type.
• You can also set the right and left indent margins using the indent tools on the Ruler bar.
Alignment of the paragraph can also be set from the Paragraph format window or by clicking
on the applicable alignment button (left, center, right) on the Format bar. More ..More ..More ..More ..
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Word Wrap Options:

There are three word wrap options you can choose.
1. Wrap to Ruler: This usually is the best choice since the result is basically a
WYSIWYG (what you see is what you get) screen display. This means that your screen
display is basically the same as how the document will be printed.
2. Wrap to Window: Does what it says. Text paragraphs that do not have a hard
carriage return/line feed will expand and contract based on the size of the window.
3. No Wrap: This means a paragraph is displayed in one, long, line. The
arbitrary maximum width in no wrap mode is about 140 inches.
Note: Word wrap is only for screen display and does not affect the printed
document. When printing, RoofCalcWriter uses the Page Setup measurements to structure
the layout of your document. More.. More.. More.. More..

The Ruler Bar and Page Set-Up: 

The ruler is also affected by the measurements you
choose. For example, if you choose letter paper (8½x11) and left and right margins of 1 inch
then the ruler will display 6½ inches of printable width area. That is 8½ - 2 = 6½. If you
chose Landscape as the orientation then the ruler would display 9 printable width inches.
which is 11- 2 = 9.
 Print and Set Printer: You may also change the default printer and print directly from the
setup dialog. Changing the printer from the Page Setup dialog does not change your
windows default printer. It only changes where the current document will be printed. More ..More ..More ..More ..

Using the Picture Camera    

From the Insert menu, choose the camera... menu or click the camera icon on the toolbar.
Your mouse pointer will turn into a crosshair, select any square section of your screen and it will be inserted 
into your document at the current curser location or just your windows clipboard.. More..More..More..More..

Insert a picture    

From the Insert menu, choose the picture... menu or click the picture icon on the toolbar.
A dialog will open, from here navagite to your pictures. Click your picture filenames to see 
a preview. Double-click the file name or click the insert button to insert the picture into your document.
You can also drag pictures into your document from any open picture display.

 Using the Format Painter   

 The format painter allows you to easily copy the formating from selected text to other text.
 Select the text you want to copy the format, click the paint brush icon on the menu or toolbar.
Your cellpointer turns to a paint brsh, select the text to apply the formating to.
The text formating to be copied must all have the same formating eg: Selecting 2 different colors or sizes, etc

Inserting Characters   

This feature displays the ASCII/ANSI character set for the currently selected font. This
gives you easy access to extended characters in a font set like ¿, ©, ™, etc. Similar to the
charmap.exe program supplied with windows, you can insert a character or characters in the
current document with a click of the mouse. The window will also display the key code to
insert those characters directly from the keyboard.

Inserting dates and/or time    

When choosing this option a Date and Time dialog window will display. You will be able to
choose from several different formats and combinations of the current date and time. When
clicking the Okay buttons the date/time in the style selected will be inserted at the current
cursor location. Your selection will be remembered until you choose a different format.
Clicking F5 will insert your last selection at your curser location.

Using Quick Squares    

Open the Quick Squares Calculator from the view menu or Ctrl+Q shortcut. Enter your roof measurments into
the calculator and your squares will be totaled. You can optionally enter the total into your document by 
clicking the transfer button. More..More..More..More..
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Using the Multi-Function Calculator    

Open the Multi-Function Calculator from the view menu or Ctrl+K shortcut. You can optionally enter the total
into your document by clicking the transfer button. More ..More ..More ..More ..
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Menus

  All the functions in RoofCalcWriter main screens can be accessed thru menus. In fact a few functions can only be
be accessed thru a menu. Most of the most commonly used functions have keyboard shortcuts. Below we have
provided 
a list of functions available thru your menus. 

These functions are only availabe thru the menus in Document Designer and Paragraph and Sentence

Manager.

For RoofCalcWriter Main Screen Menus click herehereherehere .

        Back to RoofCalcWriter Main menu.

 A dialog opens where you can change or set print options.

  See how your document will look before printing.

   Print the current document.

   Email the open document as an attachment.

     Opens you default local email, if you have one.

 Closes the open screen and opens RoofCalcWriters main screen.

  Undo or redo your last action.

  Cuts your selected text to the clipboard.

  Copies what is selected to the clipboard.

  Pastes clipboard data at the current cursor position.

   Deletes  selected.

  Selects everything in your document.

   You can hide or show any combination of toolbars and rulers.

  Spell checks your the current text.

  Set you top ruler measurement to inches or centimeters.

  Set you top side ruler measurement to inches or centimeters.

 Opens a picture dialog and inserts a pictures at the current cursor location.

Opens a table dialog and inserts a table at the current cursor location.

 Opens the date time dialog.

  Insert a blank box at your current cursor location.

 Insert a checked box at your current cursor location.

  Opens a general purpose calculator.
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   Opens a symbols/Character  form with over 200 selections, you can insert into your documents.

   .  Opens your capture camera.

 Opens your system font dialog.

 Shows text formating options.

  Place or remove bullets.

 Highlight the back color of selected text.

  Copy text formating between texts.

 Opens a dialog where you can format your paragraphs.

  Set your document tab stops. You can also click your ruler.

 Clears all your text formating and removes images.

Set the width of you typed text.

Menu RoofCalcWriter Main Screen.    

  Start a new estimate.

 Open a saved estimate.

 Save the current estimate.

 Save under a different name or to a different folder.

  Opens you default email client on your pc.

   Print RoofCalcWriter main screen

   Close and exit.

  Open your most recently saved file.

                     Enter your unlocking code after purchase.

      Get information about your computer.

   Open the floating camera.

  Open document Designer.

   Open Paragraph and Sentence Manager.

 Open your general purpose calculator.

  Open Quick Squares.

  Open your number details window.

 Open Calculation details window.
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  Open Quick Bid.

 Open Document Manager.

  Open your address book.

  Open price Per Square.

 Open an online map

 Open an online weather report

  Detail cost a bid or create a work order

            Send us Ideas or recommendations

   Open a year month calendar

       Get help
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Rulers and Page Layout

  RoofCalcWriter provides document side and top rulers.
 You can display measurements in inches (default) or centimeters.

Page Margins

  The ruler calculates the page size depending on the paper type (letter, A4, etc.) and margins you've chosen in the
Page Setup dialog 
 available from the file menu.  The page orientation, portrait or landscape, will also affect the width of the page and
therefore the ruler.
 
Indent Margins

  You can change the paragraph left and right indent margins by sliding the margin indicators located on the ruler tool
bar or set them
  from the paragraph dialog window available in the Format menu.
 
Ruler Tab Set Control

 You can set tab stops by left clicking the ruler where you want to set them. You can move set-tabs by pressing the
left mouse button on
the tab indicator and dragging it to the location you wish.  To delete tab stops, right click on the tab indicator.  The
tab dialog will pop-up 
and you can remove an individual tab or clear all tabs for the paragraph.  Alternatively you can set, move or delete
tabs for a selected 
paragraph by choosing the Tab option in the Format menu.
 
Word Wrap

There are three choices of Word Wrap.

1. Wrap to Ruler:  This usually is the best choice since the result is basically a WYSIWYG (what you see is what
you get) screen display. 
  This means that the screen display is basically the same as how the document will be printed.
2. Wrap to Window:  Does what it says.  Text paragraphs that do not have a hard carriage return/line feed will expand
and contract based 
  on the size of the Classy Writer window.
3. No Wrap:  Not sure why anyone would choose this option.  Basically it means a paragraph is displayed in one,
long, line. 
The arbitrary width of the rich text box in no wrap mode is 200,000 twips which is almost 140 inches.

   Note:  Word wrap is only for screen display and does not affect the printed document.  When
printing, RoofCalcWriter uses the 
   Page Setup measurements to structure the layout.

   The side ruler is an indicator of the height of your page.
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Using Calculators

The calculators included in the RoofCalcWriter program are for convience. They are not 
needed by RoofCalcWriter.
Quick access to calculators can be very handy. Use them if want or not.

RoofCalcWriter has a general purpose calculator, an addition calculator and a roofing squares calculator.
You can open these calculators from your View menus.

In the Paragraph and Sentence Manager screen, the results of your calculations can be transfered 
into your documents. From Price Per Square your calculations are entered into the material row.
 From all screens your calculation results can be copied to your clipboard.
The multi-function calculator supports multiplication, division, subtraction and addition.

You can use your keyboard numbers and math operators or click the buttons.  

The Multi-Function Calculator   more..more..more..more..

 

The Quick Squares Calculator  

 We added Quick squares for users to quickly determine how many squares a roof will need.
You can add pitch to your square feet total by selecting the proper pitch. Use it if you want.

  

The addition calculator is opened from your Job Cost Grid and can be used to total your 
extras if needed.
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Date and Time

 You can choose between 14 different date time formats to use in your documents.
  For convience the format you choose can be entered at anytime by the keyboard 
  shortcut F5. This format will be used the next time you open the program.

 Make a selection and it will be entered at your current cursor location.
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Paragraph Management

Paragraph Formatting:

While margins for the entire document are set from the Page Set-Up window, you can
modify left and right indent margins and the alignment of each individual paragraph.
Step 1: Click anywhere in the paragraph you want to format.
Step 2: On the Format menu, click Paragraph.
Step 3: Under Indentation, type a measurement of how far to indent the paragraph.
 You can indent all of the paragraphs in a new document by changing the format options
before you begin to type.
 You can also set the right and left indent margins using the indent tools on the Ruler bar.
Alignment of the paragraph can also be set from the Paragraph format window or by clicking
on the applicable alignment button (left, center, right) on the Format bar.
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Print Page Setup

Applies to Document Mananger and Paragraph and Sentence Manager.

Choose the Page Set-Up option from the File menu. The window pictured below will appear on
your screen. From this window you can choose the paper size/type, orientation, and margins.
The settings you enter here will apply to the whole document.

There are several different paper sizes from which to choose including A4, Letter, Legal and
various envelopes. Letter is the default paper size.

Margins: By default, all margins are set to one inch (25.4mm). The minimum margin that
can be set is .25 inches. A header or footer displays at .25 inches from the top and bottom
respectively. If your margins are less than .50 inches these may not display correctly.

 Headers and Footers: Page Set-Up is also where you may create a header or footer for
your document. While the header and footer will not be visible on screen they will appear
on every page of your printed document. A header or footer displays at .25 inches from the
top and bottom respectively.
We use special ampersand codes to display special text in headers and footers. The ampersand
codes are &l, &c, &r, &f, &d, &t and &p. The &l, &c, and &r codes are for alignment (left,
center, right), &f will print the filename, &d today's date, &t the time and &p the page number.
You can also combine those with words. For example &c Page: &p will print the word " Page: "
followed by the current page number centered on the page. A maximum of 60 characters may
be displayed in a header or footer.

The settings you enter will be remembered when opening RoofCalcWriter.
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Inserting Symbols/Characters

Applies to Document Manager and Sentence and Paragraph Manager

To open from your Insert menu click  

You can choose from over 200 Symbols and Characters.

The Keystroke equivalent is shown if you want to use your keyboard. To insert you can double-click 
your selections or click the insert button.
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Using Tables

Applies to Document Manager and Sentence and Paragraph Manager

 RoofCalcWriter gives you the ability to create simple tables.
From the Format menu, choose the Table... menu or click the toolbar table icon on the toolbar,
a window appears where you can set the number of rows,
columns, column width, and if you want, an option for the table to be centered. 

If you want all columns to be the same width then enter, in inches, the desired width. If the
columns are to be of varying widths, click the selection button and enter the widths of each
column as prompted. When finished click OK and the table will be displayed at the cursor
position in your document. You may then enter the desired text in your row and column cells.
You can also center the table by selecting the center table check box.
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Tab Stops

 Setting Tab Stops:
To set or remove tab stops in paragraphs:
Step 1: Select the paragraphs for which you want to set tab stops.
Step 2: On the Format menu, click Tabs or press Ctrl+T.
Step 3: In the Tabs dialog box, do the following:
• To set a tab stop, type the measurement for a new tab stop in Tab stop position, and then click Set.
• To delete a tab stop, click it in the list, and then click Clear.
• To delete all tab stops in the selected paragraph, click Clear All.
You can also set tab stops by left clicking the ruler where you want to set them. To delete,
right click and the tabs dialog window will appear and you can delete any of the tab stops.
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Wrap

Word Wrap Options: 

There are three word wrap options you can choose.
1. Wrap to Ruler: This usually is the best choice since the result is basically a
WYSIWYG (what you see is what you get) screen display. This means that your screen
display is basically the same as how the document will be printed.

2. Wrap to Window: Does what it says. Text paragraphs that do not have a hard
carriage return/line feed will expand and contract based on the size of the Classy Writer window.

3. No Wrap: This means a paragraph is displayed in one, long, line. The
arbitrary maximum width in no wrap mode is about 140 inches.
Note: Word wrap is only for screen display and does not affect the printed
document. When printing,  Classy Writer uses the Page Setup measurements to structure
the layout of your document.
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Document Markers

 Placement markers are inserted into documents as place holders to recieve information from the

RoofCalcWriter program.  These markers can be moved or removed if desired. The RoofCalcWriter program

scans your document and finds these markers and places information over these marker locations.

To remove any delete the desired markers.

If you later decide put a marker back into a document the names have to be typed exactly as shown below or they will

not be found.

If you add a marker and no information is found to overwrite the marker, the marker will be erased.

Different documents contain different markers. (See below)

 Example:

The customer name in the main program will be placed over the #name marker.

Marker Meaning Proposal Invoice Change Order Certifaction Letter

#Name Customer name or Contractor Name Yes Yes Yes Yes Yes

#address Customer Address or Contractor Address Yes Yes Yes Yes Yes

#citystatezip City, State, Zipx Yes Yes Yes Yes Yes

#date Current date Yes Yes Yes Yes Yes

#price Price specific to document type Yes Yes Yes No No

#date2 Current date for a 2nd date Yes Yes Yes Yes Yes

#paragraph_marker Pargraph placement Yes Yes Yes Yes Yes

#changeprice Amount of change order price No No No Yes No

#newprice #price + #changeprice No No Yes No No

#jobaddress If bid by contractor Yes Yes Yes No No

#jobcity If bid by contractor Yes Yes Yes No No

#planlotnumber If bid by contractor Yes Yes Yes No No

#hphone Customer home phone number Yes Yes Yes Yes Yes

#wphone Customer work phone number Yes Yes Yes Yes Yes

#cphone Customer cell phone number Yes Yes Yes Yes Yes

#faxnumber Customer fax phone number Yes Yes Yes Yes Yes

#email Customer email address Yes Yes Yes Yes Yes

Opening the document marker helper window

 You can type your document marker names or use the form below. You can open the placement marker form from

the insert menu 

Or by double-clicking anywhere in Document manager window. To insert markers from this form click your selection

and 

the marker will be placed at your cursor location.
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Keyboard Shortcuts

For users who prefer to use the keyboard for their input we have provided many keyboard shortcuts.

Wording containing keyboard shortcuts can be identified by an underline under one of the letters.

This means you can press Ctrl + the underlined letter. This the same as clicking it with the mouse.

In some cases more than one key will do the same thing. Such as:

You can always exit the program by pressing the Esc key.

Remember you can press F+1 for help on the procedure you are currently working on.

Virtually all movement, formatting and editing options are available from the
keyboard as well as from menu's and toolbars. A list of all keyboard actions is listed below.

For Main Screen Keys click herehereherehere .

Cursor Movement Action

Left Arrow One character to the left

Right Arrow Arrow One character to the right

Up Arrow One line up

Down Arrow One line down

Home To the beginning of the line

Page Up One screen window up

Page Down One screen window down

Ctrl + Left Arrow One word to the left

Ctrl + Right Arrow One word to the right

Ctrl + Up Arrow One paragraph up

Ctrl + Down Arrow One paragraph down

Ctrl + End To the end of the document

Ctrl + Home To the beginning of the document

Ctrl + Page Down To the end of the screen window

Ctrl + Page Up To the beginning of the screen window

Edit Keys Action

Ctrl + X or Shift + Del Cuts and copies selected text

Ctrl + C or Ctrl + Insert Copies selected text to clipboard

Ctrl + V or Shift + Insert Paste text from clipboard

Delete Deletes selected text or current character

Shift + Left Arrow Select one character to the left

Shift + Right Arrow Select one character to the right

Shift + Up Arrow Select one line up

Shift + Down Arrow Select one line down

Shift + End Select current line right

Shift + Home Select current line left

Ctrl + A Select All text and graphics in document

Ctrl + Z or Alt + Backspace Undo last formatting made in document

Format Keys Action

Double-Click Opens document markers (Document Designer only)

Ctrl + B Toggle Bold font

Ctrl + F Format Painter

Ctrl + H Highlight Color

Ctrl + I Toggle Italic font

Ctrl + O Text Color

Ctrl + U Toggle Underline font

Ctrl + Y Toggle Strike through font

Shift + F7 Superscript up 2 pts

Shift + F8 Subscript down 2pts

F2 Font and attribute selection dialog window
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Other Shortcut Keys Action

F1 Display User Help Manual

Shift + F1 Display About window

Ctrl + F1 Turn underline typing on and off (Paragraph & Sentences only)

F3 Insert Picture at current cursor location

F5 Insert Date/Time

F7 Spell Check Document or Selected Text

Ctrl + F2 Open Calendar (Paragraph & Sentences only)

Ctrl + D Capture Image to Document

Ctrl + E Email the Current Document

Ctrl + K Open Multi-Purpose Calculator

Ctrl + L Open Your Local Email

Ctrl + N Capture image to Clipboard

Ctrl + Q Open Quick Squares

Ctrl + P Print document to currently selected printer

Ctrl + T Display Tab dialog window

Main Screen Keys Action

F1 Display User Help Manual

Ctrl + A Save as a different name or folder

Ctrl + B Open Address Book

Ctrl + D Open Document Designer

Ctrl + G View Document Manager

Ctrl + I Open Number details

Ctrl +  J View Calculation Details

Ctrl + L Open Local Email

Ctrl + M Open an online Map

Ctrl + N New project

Ctrl + O Open existing project

Ctrl +  P Print

Ctrl + Q Open Quick Bid

Ctrl + R Open Paragrah and Sentence Manager

Ctrl + S Save current document

Ctrl + U Open Quick Squares

Ctrl + W Get an online Weather Forcast

Ctrl + Y Open Calculator

Ctrl+ X or Esc Exit

Ctrl + Z Open Paragraph and Sentence Manager

Ctrl + F2 Open calendar

F5 Open Price Per Square

F6 Open Detail Or Per Square Pricing

Main Screen (Option Buttons) Action

F1 Display User Help Manual

Ctrl + E Eaves

Ctrl + F Roof Area

Ctrl + H Hips

Ctrl + K Rakes

Ctrl + T Top Ridges

Ctrl + V Valleys

Detail Pricing screen Action

F1 Display User Help Manual

Ctrl + B Open Address Book
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Ctrl + C Open Calculator

Ctrl + D Print Detail Cost

Ctrl + H Detail Cost help

Ctrl + L Print a Price List

Ctrl + M Get an online map

Ctrl + N Main screen

Ctrl + O Open options

Ctrl + W Get an online Weather Forcast

Ctrl + X or Esc Close & Exit

Per square  Pricing screen Action

F1 Display User Help Manual

Ctrl + B Open Address Book

Ctrl + C Open Calculator

Ctrl + M Get an online map

Ctrl + N Main screen

Ctrl + P Print a work order

Ctrl + W Get an online Weather Forcast

Ctrl + X or Esc Close & Exit
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Choose a printer

Changing the printer from the Page Setup dialog does not change your windows default printer.
 It only changes where the current document will be printed. Open the change printer

from the page setup dialog.  

Choose from the list of printers installed on your system.
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Print Preview

See how your document will look before printing.

Choosing this option will display a print preview window. Here you may view how the
document will appear on the printed page. You may view each page by clicking Next or
Previous or by selecting the page number from Page drop down box. You can set the zoom
size at 25. 40, 50, 75 or 100%.
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Toolbar Buttons Main Screen

For Document Designer and Sentence and Paragraph Manager Toolbar buttons click here.here.here.here.

We will explain each main screen toolbar button here.

All the Toolbar buttons can be accessed thru the menusmenusmenusmenus ....

 Starts a new estimate

 Opens a saved estimate

  Saves the current open estimate

  Print the current estimate

   Choose where to save an estimate

  Open your address book

   Get an online map to your job

 Open program options

  View the totals of your calculations

   Opens quick bid for extras or use it when entering calculations is un-wanted

  View the number details of the numbers you have entered

 Open Document Manager

 Open Paragraph and Sentence manager

 Open Document Designer

 Open Price Per Square
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Auto Fill Detail Cost

This feature provides a fast and easy way to total up detail costs. It works like this:

The program searches for items in your Material price list that match the materials in your job cost grid.

When matches are found the are added to your Material Detail Cost and get totaled. The totals are calculated like this:

Units from the Job Cost grid times the price in the Material Price List.

To automatically add materials and quanities to your material detail cost do this:

Enter your roof measurements into the RoofCalWriter main screen then open detail cost. 

Click this button:  this will look at the text in the Job Cost grid and find matches in your price

list and them to your detail material cost grid. It then totals them up.

Important !
The wording between the Job Cost Grid and Price List Grid must match exactly or it will not be added and

calculated.

You can then continue adding materials by clicking the price list or typing them in manually.

Notes: 
If the Job Cost Units column contains no units the item will not be added.
The same method is used to create a Work Order when using Per Square Pricing, although no prices are copied.
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Calculator General Purpose

The general purpose calculator can be used for anything you want. It can be opened from the View menus on the
main screen, the detail costing screen , and the Per Square Price Screen. 
The Transfer button is disabled when opened from a menu.

It can also be used in the detail costing grids as follows:
Material Detail Cost, can be opened from the Units and Price columns.
Double-click the cell you want the calculation results entered into. After doing your calculations click the Transfer
button.

Labor Grid, can be opened from the Units and Rate columns.

Misc/Other Grid, can be opened from the Units and Rate columns.

   

This calculator can also be used in the Price Per Square, Material tab.

By using the copy to clipboard you can enter your calculations into any program on your computer by pasting the
results.
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Detail Cost Total Grid

The Detail Cost Total grid is a total of all the data you entered into the other grids.
We have included two of these grids and they are the same.

 You see this grid on the main RoofCalcWriter screen and the Detail Costing Screen.
The profit and Overhead can be changed from the Options toolbar button or from the Options on the Tools 
menu. You can change this at anytime and your price will be recalculated and updated.

 

Clicking the blue button copies the price to the bottom row. If you make changes the Optional price will not be
updated.

You cannot add rows to this grid, but you can type into the Information column.

Related
Deta il Pr ic ingDeta il Pr ic ingDeta il Pr ic ingDeta il Pr ic ing
Labor GridLabor GridLabor GridLabor Grid
Job C ost GridJob C ost GridJob C ost GridJob C ost Grid
Misc/Other GridMisc/Other GridMisc/Other GridMisc/Other Grid
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Detail Pricing

Using Detail Pricing you can select items from your price list and add them to your material cost grid. The same

process is 

used in Per square Pricing when creating a work order.

The detail costing screen contains 5 grids.

1.   This is your saved material price list. Use

this grid to hold your materials prices. Clicking the far left blue(Red Circled)column below adds that rows material and

price to your

material detail cost or you can click the green arrow(green circled) after making a selection. Enter your quanities into

the units column. Click the blue 

arrow(blue circled) expands or compresses the grid. You can also type materials directly into Material Detail Cost grid.

To add a new row press the enter key in the last row and the description column.

2.   Add your material prices to this grid. Pressing enter in the

Price column

just above Total adds a new row. You can add as many rows as you need. When adding materials by clicking the left

grid the Material 

Detail Cost will add rows as needed.

3.    This grid is system maintained and totals the prices from each grid.

Pressing the enter key in the last row of these grids adds a new blank row. You can add as many rows as you need.

(Does not apply to the Job Cost Totals grid)

4.    Add other costs, Such as Tear-off, Permit or whatever. See Misc/Other Grid Misc/Other Grid Misc/Other Grid Misc/Other Grid.

5.    Enter your labor costs here. See Labor GridLabor GridLabor GridLabor Grid .
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Labor Grid

Applies to Detail Pricing Mode Only

Enter your prices for labor here. If you have selected the add payroll tax it will be added.
To add rows press the enter key in the row just above the Sub Total or Total in the rate column.
If payroll taxes are not being added then pressing the enter key just above the Total row will add another row.
You can change or remove your labor tax rate anytime and your totals will be recalculated.
Open the helper screen by clicking the  icon.    

           

The add Labor button will open your saved labor prices from Price Per Square. Clicking numbers in your labor grid will
add the numbers into the rate column.

The Add OSB button will search your Material Detail Cost grid, find and add your OSB units to the units column.

A popup Calculator to aid in calculations is available by double-clicking the price column after selecting a row.
You can also select and right-click any row in the units column and open a menu to add calculations from your
estimate.
You can also Double-Click in the Units column to add the squares from your estimate.

          

The add squares option will most likely be used often, the others not so much or not at all.

 

Related

To change, add or remove your payroll tax. here here here here
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Managing Your Material Price List

The Price List with prices we have provided is for example only. You must enter your materials and prices.
Your price list is classified into sections.  The example below shows the Metals-Flashings section. You can 
delete, make new or rename these sections as follows:

1. Rename a section: Delete the name and type in a new name and click the save icon.
2. Delete a section: Delete the name and click the save icon.
3. Make a New section: Click the Clear Icon then Delete the name and type in a new name and click the save icon. 
 In all cases the message box below will confirm your action.

Notes:

  You cannot edit or rename the section "All Materials"
  You must have a least one section besides  "All Materials"

   

    

The refresh button is used to refill your saved list if desired. When adding items from your price list to your Material
Detail Cost
they are removed from from your Price List (Not permantely) as to avoid duplicates being added.

Related

Material P r ice ListMate r ial P r ice ListMate r ial P r ice ListMate r ial P r ice List
Pe r Square Pr ic ing vs Detail P r icingPer Square Pr ic ing vs Detail P r icingPer Square Pr ic ing vs Detail P r icingPer Square Pr ic ing vs Detail P r icing
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Material Detail Cost

This grid is a convient way to total your material price by adding prices from your material list.
When added from your price list the quanity is always 1. Change this to the quanities you need.
Shown below is the material tax option has been selected. Most states will not use this option.
It can be added, changed  or removed from the options on the tool bar or menus. Changing this
and your price will be recalculated.

   

To add rows press the enter key in the row just above the Sub Total in the Price column. You can add as many rows
as needed.
If sales taxes are not being added then pressing the enter key just above the Total row will add another row.

Related
OptionsOptionsOptionsOptions  
Adding mate ria ls  from your pr ice l istAdding mate ria ls  from your pr ice l istAdding mate ria ls  from your pr ice l istAdding mate ria ls  from your pr ice l ist
Adding mate ria ls  from your calculationsAdding mate ria ls  from your calculationsAdding mate ria ls  from your calculationsAdding mate ria ls  from your calculations
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Material Price List

  Important ! 
 All the prices we have provided are for example only. You must enter your prices.

 The material price list is used by Price Per Square Pricing to create a work order and by the Detail Pricing mode to
create 
a work order and create a detail material cost.

We have provided sample section headings and sample prices. These sections can be deleted or renamed. New
sections can 
be added by typing in a new name and clicking save. To delete a section erase the name and click the save icon.

When adding new materials to the grid you can add new rows by pressing the enter keyboard key in the bottom row
in the
description column. You can add as many rows as needed. 
The section "All Materials" cannot be edited or deleted. Selecting this section displays the materials in all sections.

To remove a row, select the row then press Alt-Delete key combination on your keyboard or double-click the row.

Clicking the blue arrows at the top of the grid expands the the grid to display more rows.

    

When making changes be sure to click the save icon. 
When items are added to the Material Detail Cost they are removed from the price list to help prevent duplicate items
being added.

Related

Price Per Square vs  Detai l  Pric ingPrice Per Square vs  Detai l  Pric ingPrice Per Square vs  Detai l  Pric ingPrice Per Square vs  Detai l  Pric ing
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Misc Other Grid

Applies to Detail Pricing Mode Only

Enter prices here that do not apply to the other grids. Especially handy for adding non-taxable items and
job costs that are not kept in your price list. Open the helper screen by clicking the  icon.

 Enter items you use often and click the save button and they will be available for future use. To open your

saved roof removal pr icessaved roof removal pr icessaved roof removal pr icessaved roof removal pr ices  click the roof removal button. Clicking the appropriate price per square adds the 
selected price to the Misc/Other grid rate column and is calculated.

        

Pressing the enter key on your keyboard in the Price column just above the total price adds a new row.
You can add as many rows as needed.

A popup Calculator to aid in calculations is available by double-clicking the price column after selecting a row.
You can also select and right-click any row in the units column and open a menu to add calculations from your
estimate.

        

You can also double-click any row in the units column to add squares.

Related:

Pop up C alcula torPop up C alcula torPop up C alcula torPop up C alcula tor
Roof Removal P r icesRoof Removal P r icesRoof Removal P r icesRoof Removal P r ices
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Options

The options dialog provides a way to use settings on every estimate.

The following settings can be set here. Click   button on the top toolbar.

A dialog opens having five tabs.

Tab 1.       

These options  only applies to Deta il P r ic ingDeta il P r ic ingDeta il P r ic ingDeta il P r ic ing)

This tab contains the following:
Material sales Tax: (Optional)
Enter a tax rate for materials (if you add state tax to materials) Detail price will add this amount
to your total material price. No tax will be added if left unchecked.
Enter as a decimal eg: .0775 = 7.75%

OverHead-Profit: (Optional)
What you enter here will be added to your detail price. 
Enter as a decimal eg: .14 = 14%

Labor-Payroll-Tax: (Optional)
You could add all your payroll taxes together. eg: Workmans comp .41+ SS= .0765+Sui= .012 = .4985
Enter as a decimal eg: .4985 = 49.85%

Tab 2.   

This tab contains the following:
Round bid prices up to next full dollar. Eg: $4231.27 would be $4,232.00

Round material Units up to next full unit.  Eg: 12.54 rolls felt = 13 rolls
This applies to creating a work order in Per Square Pricing and Material Detail Cost in Detail Pricing mode.

Round Total Squares up to Next full square Eg: 35.47 squares = 36 squares
This only applies to Per square Pricing

Adding waste to roofing roof area squares for Valley, Hip and Rakes (Optional)
 The amount you enter here will be added to your roof area squares.
  Eg: If you entered 60 into the valley waste, then 100 / 60 = 1.67 squares will be added for 60 ft of valley.
  Rakes and hips are calculated the same way.

Tab 3.  

You must be connected to the internet to get an online map and weather report.

Select the weather and map provider you want to use.
Enter your cities name and select your state from the drop-down state combo-box.

Weather:

The RoofCalculator program will use this information for a weather report.
Map:

For a map the Address entered into your estimate will be used along with the state you enter.
If no address is entered it will use your default city and state.

Tab 4 

Fixed Fonts for underline typing.

A combo box listing all the fixed fonts on your system. Clicking the combo box changes
the Example font. You can download more fonts from varies places on the internet. After you have selected the font
you like

click the save button and that font will be used for underline typing. 

Read more on underline typing here .here .here .here .

Check for software updates on program start.

Select this option if you want the software to check for online updates each time the program starts.A internet
connection is required.
This will cause a slight delay in program startup times. 

  

3/8/2010 Document.html

C:/Program Files/…/Document.html 124/147



Read more on program updates here.here.here.here.

Tab 5  

File backupFile backupFile backupFile backup and restore to a Usb flash drive
You will need a Usb flash drive to use this utility
Clicking a button backs up or restores your bids.
Clicking a button backs up or restores your data files. (Custom headings, Price List, Price Per Square etc.)
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Price Per Sq VS Detail Pricing

RoofCalcWriter provides two pricing methods, Per Square Pricing and Detail Pricing.

    From the main screen click your selection here.

Per Square Pricing
Choose this selection if you want your bid price calculated by a price per square.

You can enter your price per square three different ways:

1. By typing in the price directly into the Job Cost Grid.

2. By clicking the PerSq Icon in the Job Cost grid  . This will open your floating price per square. You can then

   click any bottom icons to enter your price per square. Clicking two buttons will also enter your optional price per

square.

   More on this floating price per square: herehereherehere  and herehereherehere .

3. Calculate the price by using the calculator from the top menu. Select View or CTRL-Y

Clicking this icon   allows you to create and print a work order by selecting items from your price list.

Note:

 Rounding Tota l SquaresRounding Tota l SquaresRounding Tota l SquaresRounding Tota l Squares  only applies to this pricing method.

Detail Pricing
Choose this selection if you want your bid price calculated by entering all your individual material items, Labor and

other items.

Clicking this  icon    opens your Detail P r icingDetail P r icingDetail P r icingDetail P r icing window, changes the Job Cost and displays the Detail Costing

Totals Grid.

The Price Per Square prices and screens  do not apply to detail pricing.

Many of the options in Options Options Options Options only applies to Detail Pricing.
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Print Detail Cost

      Printing a detail cost  will look similar to the (scaled down) image below.
      It will contain the following:
      The heading will contain your customer name and address.
      Your material list.
      Your Detail Cost totals.
      Your Misc/Other Prices
      Your Labor Prices.
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print Work Order

You can create a work order from both price per pricing and detail pricing by clicking this button 

Create your work order by adding items from your price list or typing directly into the material list.

     

 

Your printed work order will look like this with contact information from your Main screen.

   

Your Price List can only be printed when in Detail Pricing mode.

Related

Print  Detai l  Cost  ReportPrint  Detai l  Cost  ReportPrint  Detai l  Cost  ReportPrint  Detai l  Cost  Report
Print  RoofCalculator Main FormPrint  RoofCalculator Main FormPrint  RoofCalculator Main FormPrint  RoofCalculator Main Form
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Printing A Price List

 Your printed price looks similar to this (Scaled down) This print-out prints everything in your price list.  
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Program Updates

Note on Windows Vista

If you are using Windows Vista then read herehereherehere .

You must be connected to the internet to check for or get program updates.

Program updates provides an  excellent way to keep your software up to date with the latest features and fixes.

Minor upgrades happen quite frequently and are free.
Major upgrades happen less frequently and are not free.

To check for upgrades click Tools on the top toolbar on the main screen. Select  program updates from the Tools
menu.
The program updater opens. If you are connected to the internet the software you are using will be compared
to the online version, you will see the results of the comparsion..

Click the read details for update features. Click the Download free update to install this update.

If a new free minor version is available:

Then click the download button and it will be installed.

If a new major version is available:
Major Versions are not free. Click the buy button to buy this software. After you purchase the upgraded software,
you will be instantly emailed the unlocking number. Enter this number in box provided. Click the download button.

Be sure you do not have any unfinished work open when upgrading your software, it will be lost.
None of your saved work or settings will be lost.
After your new software is downloaded it will be open automatically. The software you are using will be renamed with
a .backup extension.
If the program does not connect to the RoofGenius website, your firewall may be blocking the connection.
To read more about internet connection problems click here.here.here.here.
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Rounding Bid Prices, Material Units and Total squares

Rounding Bid Prices:
Select this option if you want your bid prices rounded up to the next full dollar.

Example: $9,376.29 Rounded up = $9,377.00

Rounding Material Units:
We realize you cannot price or order partial units. (eg: 1/2 roll felt or .32 sheets of OSB)

This option applies differently to the Pricing method you have selected as follows:

Per Square Pricing:  

This option applies to when you are creating a material list.

Select this option if you want your material units rounded up to the next full unit.

Detail Pricing:   

This option applies to creating a Material detail price list and a Work Order

Rounding Total Squares
This option only applies to Per Square  Pr ic ingPer Square  Pr ic ingPer Square  Pr ic ingPer Square  Pr ic ing

In you Job cost grid your total squares will be rounded up to the next full square.

Example: 36.47 = 37 Squares
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The 6 Main Screens

RoofCalWriter consists of many screens. Most of the screens do a specific task and are not used often.
The four main screens are used often and open the less used screens. We will cover the six main screens here.

The six main screens are:

The Main Screen
The Price Per Square Screen
The Paragraph and Sentence Screen
The Document Designer
The Detail Cost Screen
The Work Order Screen

The Main Screen

RoofCalcWriter always opens to this screen. You could do all your roofing bids here without ever opening any
other screens. You have to open the other main screens from here.

The Price Per Square Screens

Use it to easily enter your pre-determined price per square. You will need to change the prices to
fit your needs.

The Paragraph and Sentence Screen

This screen allows you to set up the wording for proposals, making, viewing and editing all
your documents. This screen will always be used when creating documents.
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The Document Designer

Use this screen to design your documents. Once setup this screen most likely will be seldom used.

 

The Per Square Pricing Work Order Screen

Use this screen when in Per Square Pricing Mode to create Work Orders.
You can also edit your price list from this screen.

The Detail Pricing Screen

Use this screen to produce a Detail Price by adding individual items for materials, labor and misc/other prices.
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You can also:

    Print your price list.
    Print a detail cost.
    Print a work order.
    Edit your price list.
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Add Sentences to Cursor Location

When creating documents In the Paragraph and Sentence Manager click the Add sentences to cursor location
checkbox.
This allows sentences to be added an to your current mouse pointer location.(Cursor location)  

To use this feature check the Add sentences to cursor location checkbox. Place your mouse pointer anywhere in
your document
then select a sentence from the sentences combobox.

   

the sentence will be added to your cursor location. To continue select another place in your document and click
another sentence.

Warning:

If you do not select a place in your document before selecting a sentence your sentence will be placed at the
beginning of your document.
In most cases this would be undesirable.

Related:

C reating ParagraphsC reating ParagraphsC reating ParagraphsC reating Paragraphs
C reating SentencesC reating SentencesC reating SentencesC reating Sentences
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Underline Typing

Underline typing is a method to fill in blank lines on a form without erasing the the line or making the line longer. For

this to work correctly

you should use a fixed width font. The font listings in the RoofCalcWriter program are the fonts installed on your

system.

These are fonts are installed in most all widows systems: Courier New and  Lucida Console 

To use this feature from the Paragraph and sentence screen select from this from the Format menu  

When creating your documents in document manager create lines by clicking the Underline Icon and pressing the

space bar until your line is 

the length you want. If your line gets too long press the backspace key.

Example:

Use it like this:

Install new                         shingles .

You can  type onto the line to fill in the blank to produce this:   Install new 35 year comp shingles.

You can also add your saved sentences  from the sentences dialog in Paragraph and Sentence Manager when creating

documents.

 

What are Fixed Width Fonts ?
Fixed width or Monospace fonts (Such as Courier New or Lucida Console), or "fixed pitch" fonts, contain characters

that all have the same character width, producing text that can be used to create forms, tabular material or

documents that require exact text line lengths.

   

In the fixed width font, notice how each letter, regardless of how wide or narrow it should be, is allotted the same

amount of width.the proportional font, notice how the letter 'i' is given a very narrow space and the letter 'm' is given

a very wide space.

See also:

Fonts installed on most windows systemswindows systemswindows systemswindows systems.

How to insta ll fonts in windows.insta ll fonts in windows.insta ll fonts in windows.insta ll fonts in windows.

3/8/2010 Document.html

C:/Program Files/…/Document.html 137/147



Calendar

Use the calendar to view or enter past or future dates. Or todays date.

It could be used like this:
Approximate Starting Date _10-21-08_    Approximate Completion Date _10-28-08_

From the Paragraph and Senteces screen you can open the calendar 4 different ways:

1. The calendar toolbar button:    

2. From the Edit menu or right clicking any where in the screen opens this menu:  

3.  From the edit menu

4. Shortcut keys CTRL+ F2

Using the calendar

 Move the months  and years by clicking the << and >>  at the top.

Click any date and it will be entered into the current cursor location in your document.

Clicking a date enters it into the cursor location. The date format used is the date you have defined in the date-timedate-timedate-timedate-time

form 

You can also change the date format from the calendar.
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Ideas Recommendations

This screen sends a email to us the information you provide.

You must be connected to the internet to send this information.

We are always adding and improving features, so let us know your thoughts.

Your thoughts and feedback are very important to us and really do help us to improve our software.

Such as:

Something you would like to see improved upon.

Something you would like added.

Something you dislike.

Something else you wish it could do.

Something does not work as expected.

Anything at all.

If you are connected to the enternet, just type your comments into the form and click the send button.

To get a reply to your comments include your email address in your message. We reply to all messages. 

 

To get a reply be sure your email is spelled correctly.
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File Backup

You turn your computer on and only get a Blue Screen, Now what ?

Your saved bids and all your data is gone.

Keep your data safe with Usb Flash drive backup. 

      

To do file backups you will need a Usb Flash Drive. They are inexpensive and can be purchased just about anywhere.

File backups is something that most users do not do enough of. Our file backup makes it easy to keep your data safe.

To open file backup from the main screen click the Options button  

Click the File Backup Restore Tab  

Plug in the flash drive and click the bid file backup or the data file backup buttons. Folders will be created on your flash

drive for bid files and data files. (BidFileBacks and FileBackups)

  

Bid file Backup
Bid files are the files you create when saving your bids. There will be none when when you first use the software, but

as you create more

bids you could have hundreds or thousands of these files.

Only files that have changed or do not exist are copied

Bid file Restore
 If your computer has died or you get a new computer then download and install the software from our website:
http:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asp

 Click the Restore bid files button.

Automatically backup files   

Choosing these options your files will always be copied to your Usb flash drive whenever they are created or

changed.  We recommend you backup 

you data files on first use. This will put data file copies on the Usb Flash drive. As you make changes these file will be

updated

 Example: You make a change to your price list (PriceList.ini) , save the change. This saves the file on your harddrive

and the UsbFlash Drive.

Note:

The Automatically update bid files option will save your bid to the Usb Flash drive each time you save a bid. (If it's

plugged in)

This could cause the slowing of saving your bids, if you have a lot of bids as they are scanned to avoid duplicates. You

may want
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may want

to turn this option off after you accumulate a lot of bids.

Data file Backup
  Data files are the files created and saved you use over and over. 

These include: 

Custom Documents with your custom headings, for proposals, invoices etc.

Sentences and paragraphs you have saved.

The prices you have defined in Price Per Square module

The material price list.

Job Cost grid settings you have defined.

Other settings you have saved

We strongly recommend you check the Automatically update feature for these files as they are only 12

small files.

When this feature is checked whenever you make changes they are updated on your flash drive. (If it's plugged

in)

Data file Restore
 If your computer has died or you get a new computer then download and install the software from our

website: http:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asphttp:RoofGenius.com/Downloads.asp

 Click the Restore data files button.

Do a manual backup

If you have installed the RoofCalcWriter Software to the default location: C:\Program Files\RoofCalcWriter then go to

that folder. Under this folder find

a folder called AppFolder. Copy this folder to your backup location. Then copy all your .bid file to the copy location.
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Overview Create Documents

Add your custom logo or create one using pictures, colored text or a combination of both. Once this is

done using the paragraph and sentence managers, produce your written documents with just a few clicks.

 Create and print beautiful professional proposals, invoices, change orders, roof certifications and letters. Fast and

easy

to use. All parts of your documents are fully customizable. Insert pictures, word art, your logo or anything you can

copy

and paste. In todays aggressive business world, it is important for roofing contractors to use the tools they need to

stay competitive.

Using a proposal-generating software program can help win more bids and save you a lot of time. 

 Document Designer is designed to use proposal templates.

By using templates for proposal writing, the program allows you to write proposals quickly and accurately.

The templates ensure consistency, and remind you of what to include. You create your  header, body and footer text

including legal clauses for all your documents.

 Imagine a customer looking at 3 proposals, yours and 2 others. How does yours match up? With-out a professional

looking easy to read proposal you could lose the job right here.

       Features

Add your logo, word-art or custom lettering 
Create custom templates to be used again and again
Create custom saved paragraph templates
Create custom saved sentence templates
Add a saved paragraph to your proposal with 1 click
Add sentences to your proposal with 1 click
Saves your work with 1 click by last-name address
Saves your work to your address book to be used again

Print Preview your document before printing.

Insert tables

Insert symbols
Prints your document with 1 click
Tool bar has full text formatting features
Adds text to image to better control document layout 

Copy, cut and paste from any Windows based program.

Works with all Windows
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Windows Vista

 The RoofCalcwriter program is designed to be run as a standard user as Microsoft recommends. It can be run as

adminisrator

you will be a lot safer if running as a standard user.

Windows Vista automates the processes that help maintain the health and security of your PC and keeps your PC

running at its best 

with automatic performance self-tuning and diagnostics, and programs like Windows Defender and Windows Internet

Explorer 7. 

Windows Defender technology helps minimize pop-ups and security threats posed by spyware and other invasive

programs.

Windows Internet Explorer 7 helps protect your computer against malware, fraudulent websites and online phishing

scams. 

Plus, you can preserve critical system settings and files such as pictures, music and movies by scheduling automatic

system and network backups.

The RoofCalcWriter does not require you to be an administrator to use the program, however to download and install

program updates

require you to start the the RooFCalWriter as adminisrator.

Run As Administrator

To start the RoofCalcWriter as Administrator Right-Click the desktop shortcut or the start menu Item. 

From the menus select Run As administrator as below.

This dialog will look different on Windows XP.
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Smtp Server

What does SMTP stand for ?

Smtp = Simple mail transfer protocol

Should I specify a Smtp server ?

When using a dynamic IP address (most individuals are) their can be many issues with sending emails

without specifying

a smtp server. If your emails are not being sent or are reporting an error, then specify a smtp server.

IP Addresses

IP addresses are the fundamental method for computers to identify themselves on most computer

networks. Every computer (or other network device) connected to the Internet has an IP address.

How do I find my Smtp server settings ?

 You can use your ISp's server or any on line smtp server where you have an email account. We

recommend you Google search

using the search term, example for hotmail: "smtp settings hotmail"

List of common SMTP Servers:

AOL - smtp.aol.com

Adelphia - smtp.blk.adelphia.net

AT&T - mailhost.worldnet.att.net

Charter Communications - smtp.charter.net

Comcast - smtp.comcast.net

Gmail - smtp.gmail.com

Hotmail - smtp.live.com

Netzero - smtp.netzero.net

PacBell - mail.pacbell.net

PeoplePC - mail.peoplepc.com

Verizon - outgoing.verizon.net

Yahoo - smtp.mail.yahoo.com

Juno - smtp.juno.com

SprintPCS - smtp.sprintpcs.com

SpeakEasy - mail.speakeasy.net

Example: Using gmail smtp server:

Smtp server settings
 Server - Your smtp server

 My server requires authenication - Most do, if checked you must supply a username and password.

 User - Your username you use to lob into your email.

 My server requires secure connection - Most do, some do not.

 Port - Most use port 25, get this information from your smpt provider. (Default is 25)

 Starttlis - This rarely needs changing. (Default is one.)

  More on starttlis: http://www.ntmail.co.uk/kb.htm?q=1450http://www.ntmail.co.uk/kb.htm?q=1450http://www.ntmail.co.uk/kb.htm?q=1450http://www.ntmail.co.uk/kb.htm?q=1450
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Email Viewer

You can open and view emailed documents from the view toolbar menu item from the main screen 

or from the button on the email form. 

Thumbnails will look simular to these:

Double-click any image to view full size.

Select an image and press the delete keyboard key to delete images.
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Defaults

What is Default?

This term is used to describe a preset value for some option in a computer program. It is the value used when a

setting has not been specified by the user.

Some defaults in the RoofCalcwriter are preset. Others are not preset, but can be set for the user. Other defaults are

set based on the last setting used.

Some examples:

If most of your work is comp shingles it would be benificial to make comp shingles your default as below:

 

Or if the same data entry person is doing bids then

Here is another example where a default file name is supplied for a document. It can be typed over with any name

you choose.

An example of the the last used setting:

The next time the program opens these settings will be used.
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Email Setup

To send an email do the following;    

You must enter a valid email address to activate the Send Email button. Valid does not mean the we are

checking to make sure it exists. Valid means we are checking the syntax. It would be a waste of time to

try to send an email with no chance of being successful. Read more here.here.here.here.

You must be connected to the internet to send an email.

If you are not connected you will get a host not found error message.

In Address BookAddress BookAddress BookAddress Book, after entering a valid email address click the email button. Send Mail opens. 

You can also open the email program from the email button on the main form or main form menu item.

The following fields need to be set for first time use;

SMTP Server 

Sender Name 

Sender Email

User Name

Password

To specify a SMTP server click this button: 

   

 

SMTP ServerSMTP ServerSMTP ServerSMTP Server

In order to find your SMTP server name, the easiest way is to ask your ISP or email provider, who will provide you the

correct information.

You can also try to find it on your email client (like Eudora, Outlook, Netscape Messenger). 

Outlook 2000 and newer: Go to the Tools|Accounts|Properties|Servers menu. Copy the value in the "Outgoing mail

(SMTP)" field. 

Outlook Express 5: Go to the Tools|Accounts|Properties|Servers menu. Copy the value in the "Outgoing mail (SMTP)"

field. Netscape Messenger: Go to the Edit|Preferences|Mail & Newsgroups|Mailservers menu. Copy the value in the

"Outgoing mail (SMTP) server" field.

User :The user name you use to log into your email.

Password :The password you use to log into your email.

Sender Email :Your Email address

My server requires SSL: Get this information from email provider. (Most do).

Port: Get this information from email provider. (Most use port 25)

Startls : This hardley ever needs to be changed.
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Defaults

What is Default?

This term is used to describe a preset value for some option in a computer program. It is the value used when a

setting has not been specified by the user.

Some defaults in the RoofCalcwriter are preset. Others are not preset, but can be set for the user. Other defaults are

set based on the last setting used.

Some examples:

If most of your work is comp shingles it would be benificial to make comp shingles your default as below:

 

Or if the same data entry person is doing bids then

Here is another example where a default file name is supplied for a document. It can be typed over with any name

you choose.

An example of the the last used setting:

The next time the program opens these settings will be used.
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Email Setup

To send an email do the following;    

You must enter a valid email address to activate the Send Email button. Valid does not mean the we are

checking to make sure it exists. Valid means we are checking the syntax. It would be a waste of time to

try to send an email with no chance of being successful. Read more here.here.here.here.

You must be connected to the internet to send an email.

If you are not connected you will get a host not found error message.

In Address BookAddress BookAddress BookAddress Book, after entering a valid email address click the email button. Send Mail opens. 

You can also open the email program from the email button on the main form or main form menu item.

The following fields need to be set for first time use;

SMTP Server 

Sender Name 

Sender Email

User Name

Password

To specify a SMTP server click this button: 

   

 

SMTP ServerSMTP ServerSMTP ServerSMTP Server

In order to find your SMTP server name, the easiest way is to ask your ISP or email provider, who will provide you the

correct information.

You can also try to find it on your email client (like Eudora, Outlook, Netscape Messenger). 

Outlook 2000 and newer: Go to the Tools|Accounts|Properties|Servers menu. Copy the value in the "Outgoing mail

(SMTP)" field. 

Outlook Express 5: Go to the Tools|Accounts|Properties|Servers menu. Copy the value in the "Outgoing mail (SMTP)"

field. Netscape Messenger: Go to the Edit|Preferences|Mail & Newsgroups|Mailservers menu. Copy the value in the

"Outgoing mail (SMTP) server" field.

User :The user name you use to log into your email.

Password :The password you use to log into your email.

Sender Email :Your Email address

My server requires SSL: Get this information from email provider. (Most do).

Port: Get this information from email provider. (Most use port 25)

Startls : This hardley ever needs to be changed.
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